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Safety precautions
The following precautions ensure the proper use of the printer and prevent the printer from being
damaged. Follow these precautions at all times.
●

Use the power supply voltage specified on the nameplate. Avoid overloading the printer's electrical
outlet with multiple devices.

●

Ensure the printer is well-grounded. Failure to ground the printer may result in electrical shock, fire,
and susceptibility to electromagnetic interference.

●

Do not disassemble or repair the printer yourself. Contact your local HP Service Representative
for service, see Contact HP Support on page 158.

●

Use only the electrical cord supplied by HP with the printer. Do not damage, cut, or repair the power
cord. A damaged power cord has risk of fire and electric shock. Replace a damaged power cord
with an HP-approved power cord.

●

Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of
the printer. Doing so may cause fire, electric shock, or other serious hazards.

●

Power OFF the printer and unplug the power cable from the power outlet in any of the following
cases:
◦

When placing your hands inside the printer

◦

If there is smoke or an unusual smell coming from the printer

◦

If the printer is making an unusual noise not heard during normal operation

◦

A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal
parts of the printer

◦

During an electrical (thunder/lightning) storm

◦

During a power failure.

HP Start-Up Kit
The HP Start-Up Kit is the CD or DVD that comes with your printer; it contains the printer's software and
documentation, including introductory multimedia tutorials to help you to get a good first print.
NOTE: The HP Start-Up Kit is provided on CD in Japan, and on DVD elsewhere in the world. The rest
of this guide will refer to the DVD version only.

Using this guide
Using your printer (on DVD) and the Quick Reference Guide (on paper) are organized into the following
chapters. The most complete source of information is Using your printer.

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.
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Use and maintenance
These chapters help you carry out normal printer procedures and include the following topics.
●

Installing the software on page 9

●

Personalizing the printer on page 17

●

Paper handling on page 23

●

Printing on page 41

●

Color management on page 51

●

Retrieving printer usage information on page 77

●

Handling ink cartridges and printheads on page 81

●

Maintaining the printer on page 93

Troubleshooting
These chapters help you solve problems that may occur while printing and include the following topics.
●

Troubleshooting paper issues on page 113

●

Troubleshooting print-quality issues on page 121

●

Troubleshooting ink cartridge and printhead issues on page 137

●

Troubleshooting general printer issues on page 145

●

Front-panel error messages on page 151

Support, accessories, and specifications
These chapters contain reference information, including HP customer care, the specifications of the
printer, and the part numbers of paper types, ink supplies, and accessories.

Glossary
This chapter contains definitions of printing and HP terms used in this documentation.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent
the printer from being damaged. Follow the instructions marked with these symbols.
WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal
injury or death.
CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury
or damage to the product.
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The printer's main features
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 44 in (1.12
m) wide. Some major features of the printer are shown below:
●

Print resolution of up to 2400 × 1200 optimized dpi, from a 1200 × 1200 dpi input, using the Best
print-quality option, the Maximum Detail option, and photo paper

●

HP Easy Printer Care (Windows) and HP Printer Utility (Mac OS), see Access HP Easy Printer
Care (Windows) or HP Printer Utility (Mac OS) on page 19, provides an easy-to-use interface
including:
◦

A single-point for color control

◦

Management, installation, and creation of ICC profiles

◦

Calibration of printer and display

◦

Access to the online HP Printing Knowledge Center

●

Accurate and consistent color reproduction with automatic color calibration and profiling

●

Eight-ink system providing a wide color range on matte fine art papers and glossy photo papers
for photographic and graphic arts prints and complete coverage of ISO and SWOP gamuts for color
accuracy in pre-press applications

●

Embedded Spectrophotometer for consistent and accurate color, even with paper and environment
changes and easy creation of custom ICC profiles, see HP Embedded Spectrophotometer
on page 56

●

Ink and paper usage information available from the Web from the Embedded Web Server, see
Access the Embedded Web Server on page 19

●

Paper flexibility and automatic easy load, see Paper handling on page 23, with information and
profiles accessible from the front panel, HP Easy Printer Care (Windows), and HP Printer Utility
(Mac OS)

The printer's main components
The following front and rear views of the printer illustrate the main components.
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1.

Ink cartridge

2.

Ink cartridge slots

3.

Blue lever

4.

Transparent window

5.

Front panel

6.

Printhead carriage

7.

Printhead

8.

Output tray

9.

Paper alignment lines

Introduction

Front view

10. Basket

Rear view
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1.

Spindle

2.

Spindle holders

3.

Quick Reference Guide holder

4.

Sockets for communication cables and optional accessories

The printer's main components
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5.

Hard power switch

6.

Power cord plug in

7.

Paper feeder

The front panel
Your printer's front panel is located on the front of the printer, in the center. It has the following important
functions:
●

Assists you in troubleshooting issues

●

Is used to perform certain procedures, such as cutting and unloading paper

●

Displays helpful animations to guide you through procedures

●

Displays up-to-date information about the status of the printer such as, the ink cartridges, the
printheads, the paper, and the print jobs

●

Displays warning and error messages, when appropriate, along with audio alerts to call attention
to a warning or message

●

Can be used to change the values of printer settings and thus change the operation of the printer.
However, settings in the front panel are overridden by settings in the printer drivers, see Installing
the software on page 9

The front panel has the following components:
1.

6

Direct access keys:
●

First key: View ink levels, see Check the ink cartridges status on page 82

●

Second key: View loaded paper, see View information about the paper on page 36

●

Third key: Unload paper, see Unload a roll on page 30 and Unload a single sheet
on page 35

●

Fourth key: Form feed and cut, see Feed and cut the paper on page 39

2.

Menu key - Press to return to the main menu of the front-panel display. If you are already on the
main menu it will display the status screen.

3.

OK key - To confirm an action while in a procedure or interaction. To enter in a submenu in the
menu. To select a value when given an option.

4.

Back key - To go to the previous step in a procedure or interaction. To go to the upper level, or
leave the option in the menu, or when given an option.

5.

Down key - To go down in a menu or option, or to decrease a value, for example when configuring
the front-panel display contrast or the IP address.

6.

Up key - To go up in a menu or option, or to increase a value, for example when configuring the
front-panel display contrast or the IP address.

Chapter 1 Introduction
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Cancel key - To abort a procedure or interaction.

8.

Power key - To turn the printer off or on, it also has a light to indicate the printer's status. If the
power key light is off the device is off. If the power key light is blinking green, the device is starting
up. If the power key light is green on, the device is on. If the power key light is amber on, the device
is in standby. If the power key light is blinking amber, the device needs attention.

9.

LED light - Indicates the printer's status. If the LED light is solid green, the device is ready. If it is
flashing green, the device is busy. If it is solid amber, there is a system error. If it is flashing amber,
the printer needs attention.

10. Front-panel display - Displays error, warnings, and information on using your printer.
To highlight an item in the front-panel display, press the Up or Down key until the item is highlighted.
To select an item in the front-panel display, first highlight it and then press the OK key.
When this guide shows a series of front-panel display items like this: Item1 > Item2 > Item3, it means
that you should select Item1, then select Item2, then select Item3.
Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your printer:
●

The PCL3 raster driver, your main printer driver

●

The HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS), see Access HP Easy Printer
Care (Windows) or HP Printer Utility (Mac OS) on page 19, allows you to:
◦

Manage the printer including color with the HP Color Center

◦

View the status of the ink cartridges, the printheads, and the paper

◦

View job accounting information, see Retrieving printer usage information on page 77

◦

Update the printer's firmware, see Update the firmware on page 100

◦

Change various printer settings (in the Settings tab)

NOTE: Windows XP Professional x64 Edition does not support HP Easy Printer Care, therefore
it cannot be installed with your printer's installer.
●

The Embedded Web Server, runs in the printer and enables you to use a Web browser on any
computer to perform the HP-GL/2 Upgrade and to check ink levels and printer status, see Access
the Embedded Web Server on page 19.

●

The RTL and HP-GL/2 driver for Windows, needed if you have the HP-GL/2 Upgrade

The printer's internal prints
The internal prints give various kinds of information about your printer. They can be requested from the
front panel without using a computer.
CAUTION: Before requesting any internal print, make sure that paper is loaded (roll or sheet), and
that the front panel displays the Ready message. The loaded paper should be at least A3 landscape
(16.53 in or 42 cm wide); otherwise the print may be clipped.
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7.

To print any internal print, press the Menu key to return to the main menu, select the Internal Prints

Introduction

menu icon

8

, then select the internal print you want. The following internal prints are available.

●

Menu map: shows details of all the front-panel display menus

●

Configuration: shows all the current front-panel display settings

●

Usage report: shows estimates of the total number of prints, number of prints by paper type, number
of prints by print-quality option, and total amount of ink used per color (the accuracy of these
estimates is not guaranteed)

●

HP-GL/2 palette: shows the color or grayscale definitions in the currently selected color palette,
requires the HP-GL/2 Upgrade

●

Service information: provides information needed by service engineers

Chapter 1 Introduction

ENWW

ENWW

Installing the software

●

Choose which connection method to use
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Connect to a network (Windows)

●

Connect directly to a computer (Windows)

●

Uninstall the printer software (Windows)

●

Connect to a network (Mac OS)

●

Connect directly to a computer (Mac OS)

●

Uninstall the printer software (Mac OS)
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Choose which connection method to use
The following methods can be used to connect your printer.

Installing the software

Connection type

Speed

Cable length

Other factors

Fast Ethernet

Fast; varies according to
network traffic

Long (100 m=328 ft)

Requires extra equipment (switches)

Jetdirect print server
(optional accessory)

Moderate; varies
according to network
traffic

Long (100 m=328 ft)

Requires extra equipment (switches)
Provides additional features
See http://www.hp.com/go/jetdirect/ for
more details

USB 2.0

Very fast

Short (5 m=16 ft)

NOTE: The speed of any network connection depends on all components used in the network, which
can include network interface cards, hubs, routers, switches, and cables. If any one of these components
cannot operate at high speed, you will have a low-speed connection. The speed of your network
connection can also be affected by the total amount of traffic from other devices on the network.

Connect to a network (Windows)
Before you begin, check your equipment:
●

The printer should be set up and on.

●

The Ethernet hub or router should be on and functioning correctly.

●

All computers on the network should be on and connected to the network.

●

The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer:

10

1.

Make a note of the IP address from the status screen on the printer's front panel (192.168.1.1 in
this example):

2.

Insert the HP Start-Up Kit DVD into your computer. If the DVD does not start automatically, run the
START.EXE program in the root folder of the DVD.

Chapter 2 Installing the software
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Click Install. The printer driver, HP Easy Printer Care, and HP Color Center are installed.

4.

Follow the instructions on your screen to set up the printer. The following notes help you to
understand the screens and make appropriate choices.
●

When asked how the printer is connected, select Connected via the network.

●

The configuration program looks for printers connected to your network. When the search is
complete, a list of printers appears. Identify your printer by its IP address and select it from
the list.

●

The configuration program analyzes the network and the printer. The program detects the
network settings and suggests the settings to use when configuring the printer. It is not
normally necessary to change any of these settings, but you can do so if you wish.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed,
which helps you to try to find your printer. If you have a firewall in operation; you may have to disable it
temporarily in order to find the printer. You also have the options of searching for the printer by its URL,
IP address, or MAC address.

Connect directly to a computer (Windows)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 socket (supported under Windows 2000, XP, and 2003 Server).
TIP: A USB connection may be faster than a network connection, but the cable is limited in length and
it is more difficult to share the printer.
1.

Do not connect the computer to the printer yet. You must first install the printer driver software
on the computer, as follows.

2.

Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not start automatically, run
the START.EXE program in the root folder of the DVD.

3.

Click Install. The printer driver, HP Easy Printer Care, and HP Color Center are installed.

4.

Follow the instructions on your screen to set up the printer. The following notes help you to
understand the screens and make appropriate choices.
●

When asked how the printer is connected, select Connected directly to this computer.

●

If you would like to share the printer with other people connected to your network, press
the Printer Properties button in the Ready to Install window, then select the Sharing tab
and enter the name under which the printer will be shared.

●

When prompted to do so, connect your computer to the printer with a certified USB cable.
Ensure that the printer is turned on.
NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this
printer.
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Printer sharing considerations
●

HP Easy Printer Care must be installed on a computer before it can be used from that computer.

●

Any other users sharing your directly connected printer will be able to send print jobs, but will not
be able to receive information from the printer—which affects printer alerts, printer status reports,
paper management, printer administration and troubleshooting.

●

Any other users sharing your directly connected printer will be unable to use the printer's own print
preview facility, although the application's print preview will still be available. See Preview a print
on page 45.

Installing the software

TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Windows) on page 10.

Uninstall the printer software (Windows)
1.

Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not start automatically, run
the START.EXE program in the root folder of the DVD.

2.

Select Install, and follow the instructions on your screen to uninstall the printer software.

Connect to a network (Mac OS)
You can connect your printer to a network under Mac OS X by using the following methods:
●

Bonjour/Rendezvous

●

TCP/IP

NOTE: The printer does not support AppleTalk.
Before you begin, check your equipment:
●

The printer should be set up and on.

●

The Ethernet hub or router should be on and functioning correctly.

●

All computers on the network should be on and connected to the network.

●

The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

Bonjour/Rendezvous connection
1.
Go to your printer's front panel and select the Connectivity menu icon
> View configuration. Note the mDNS service name of your printer.
2.
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Insert the HP Start-Up Kit DVD into your DVD drive.
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Open the DVD icon on your desktop.

4.

Open the Mac OS X HP Designjet Installer icon.

5.

Follow the instructions on your screen. You are recommended to use the Easy Install option.

6.

The printer software is installed, including the printer driver, HP Printer Utility, and HP Color Center.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer. Follow the instructions on your screen.

8.

When you reach the Select Printer screen, look for your printer's mDNS service name (which you
noted in step 1) in the Printer Name column.

●

If you find the right printer name, scroll sideways to see the Connection Type column, and
check that it shows Bonjour/Rendezvous. Then highlight that line. Otherwise, continue
searching further down the list.

●

If you cannot find your printer name with a Bonjour/Rendezvous connection type, check the
box My printer is not in the list.

Click Continue.
9.

Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

ENWW

Connect to a network (Mac OS)
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3.

TCP/IP connection
1.

Go to your printer's front panel and press the Menu key until you see the status screen.

Installing the software

Note the URL of your printer (http://XXXX11 in this example).
2.

Insert the HP Start-Up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

4.

Open the Mac OS X HP Designjet Installer icon.

5.

Follow the instructions on your screen. You are recommended to use the Easy Install option.

6.

The printer software is installed, including the printer driver, HP Printer Utility, and HP Color Center.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer. Follow the instructions on your screen.

8.

When you reach the Select Printer screen, look for your printer's URL (which you noted in step 1)
in the Printer Name column.
●

If you find the right printer name, scroll sideways to see the Connection Type column, and
check that it shows IP Printing. Then highlight that line. Otherwise, continue searching further
down the list.

●

If you cannot find your printer name with an IP Printing connection type, check the box My
printer is not in the list.

Click Continue.
9.

Continue following the instructions on the screen. When you reach the Printer Queue Created
screen, click Quit to exit, or Create New Queue if you want to connect another printer to the
network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
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If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

Connect directly to a computer (Mac OS)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in USB 2.0 socket.
Make sure the printer is either turned off, or disconnected from the computer.

2.

Insert the HP Start-Up Kit DVD into your DVD drive.

3.

Open the DVD icon on your desktop.

4.

Open the Mac OS X HP Designjet Installer icon.

5.

Follow the instructions on your screen. You are recommended to use the Easy Install option.

6.

The printer software is installed, including the printer driver, HP Printer Utility, and HP Color Center.

7.

When the software has been installed, the HP Printer Setup Assistant starts automatically, to set
up a connection to your printer.

8.

Make sure that the printer is turned on and connected to the computer with a certified USB cable.

Installing the software

1.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables
certified by the USB Implementor's Forum (http://www.usb.org/) should be used with this printer.
9.

In the HP Printer Setup Assistant, click Continue.

10. In the list of printers that appears, select the entry that uses the connection type USB, and click
Continue.
11. The following screen displays information about your printer's installation, where the name of the
printer can be modified. Make any changes you wish to make, and click Continue.
12. Your printer is now connected. In the Printer Queue Created screen, click Quit to exit, or Create
New Queue if you want to connect another printer.
13. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.
If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the
DVD.

Sharing the printer
NOTE:

ENWW

Printer sharing between users is supported under Mac OS X 10.2 and later.

Connect directly to a computer (Mac OS)
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If your computer is connected to a network, you can make your directly connected printer available to
other computers on the same network.
1.

Double-click the System Preferences icon on the Dock menu bar on your desktop.

2.

Enable printer sharing by going to Sharing > Services > Printer Sharing.

3.

Your printer now automatically appears in the list of shared printers displayed by any other
computer running Mac OS and connected to your local network.

Installing the software

NOTE: Any other users wishing to share your printer must install the printer software on their own
computers.
Any other users sharing your directly connected printer will be able to send print jobs, but will not be
able to receive information from the printer—which affects printer alerts, printer status reports, paper
management, printer administration and troubleshooting.
Mac OS 10.2 users need to enable the Show printers connected to other computers option in the
Print Center in order to see shared printers.
You may find that sharing your directly connected printer with other users will slow down your computer
unacceptably.
TIP: The best way to share the printer over a network is to connect the printer not to any computer,
but to the network. See Connect to a network (Mac OS) on page 12.

Uninstall the printer software (Mac OS)

16

1.

Insert the HP Start-Up Kit DVD into your DVD drive.

2.

Open the DVD icon on your desktop.

3.

Open the Mac OS X HP Designjet Installer icon.

4.

Select Uninstall, and follow the instructions on your screen to uninstall the printer software.
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Personalizing the printer

●

Turn printer on and off

●

Change the language of the front-panel display

●

Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS)

●

Access the Embedded Web Server

●

Change the language of HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS)

●

Change the language of the Embedded Web Server

●

Change the sleep mode setting

●

Turn the buzzer on and off

●

Change the front-panel display contrast

●

Change the units of measurement

●

Configure network settings

●

Change the graphic language setting

Personalizing the printer
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Turn printer on and off
TIP: The printer is Energy Star compliant and can be left powered on without wasting energy. Leaving
it on improves response time and overall system reliability. When the printer has not been used for a
certain period of time (30 minutes by default), it saves power by going into sleep mode. However, any
interaction with the printer's front-panel display returns it to active mode, and it can resume printing
immediately. To change the sleep mode time, see Change the sleep mode setting on page 20
NOTE: In sleep mode, the printer wakes up from time to time to do maintenance service to the
printheads. This avoids the need of doing long preparation after long idle periods.
The printer has three levels of power consumption.
●

Plugged in: the power cord is plugged into the back of the printer

●

Switched on: the switch at the back of the printer is in the on position

●

Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to
use the Power key on the front panel.

Personalizing the printer

However, if you plan to store the printer indefinitely or the Power key does not seem to work, you are
recommended to power it off using the Power key, and then also switch off the power switch at the rear.

To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare
the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the printer
has been off for six weeks or more, preparing the printheads could take up to 45 minutes.
TIP: It is strongly recommended to leave the printer powered on or in sleep mode to avoid wasting ink
and time.
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Change the language of the front-panel display
There are two possible ways to change the language of the front-panel menus and messages.
●

If you can understand the current front-panel display language, press the Menu key to return to the
main menu and select the Setup menu icon

●

, then Front panel options > Select language.

If you cannot understand the current front-panel display language, start with the printer powered
off. At the front panel, press the OK key and hold it down. While holding the OK key down, press
the Power key and hold it down. Continue to hold down both keys until the green light on the right
side of the front-panel display starts flashing, and then release both keys. You can expect a delay
of about one second. If the green light starts flashing without any delay, you may need to start
again.

Whichever method you used, the language selection menu should now appear on the front-panel
display. Highlight your preferred language with the Up and Down keys, then press the OK key.

HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) enables you to manage your printer
from a computer with a USB connection and TCP/IP.
●

Under Windows, start HP Easy Printer Care from your desktop shortcut or from Start > All
Programs > Hewlett-Packard > HP Easy Printer Care > Start HP Easy Printer Care. This
launches HP Easy Printer Care showing the printers installed.

●

Under Mac OS, launch the Mac Printer Utility by selecting STARTUP_DISK > Library >
Printers > hp > Utilities > HP Printer Utility. This launches the HP Printer Selector where you
need to add your printer by clicking More Printers.
Select your printer and click Launch Utility. This launches the HP Printer Utility.

If you have followed these instructions but failed to get through to HP Easy Printer Care (Windows) or
HP Printer Utility (Mac OS), see Cannot access HP Easy Printer Care (Windows) or HP Printer Utility
(Mac OS) on page 147.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer remotely using an ordinary Web
browser running on any computer.
NOTE:

To use the Embedded Web Server, you must have a TCP/IP connection to your printer.

The following browsers are known to be compatible with the Embedded Web Server:

ENWW

●

Internet Explorer 5.5 or later, for Windows

●

Internet Explorer 5.1 or later, for Mac OS X

●

Netscape Navigator 6.01 or later

●

Mozilla 1.5 or later

●

Mozilla Firefox 1.0 or later

●

Safari

Change the language of the front-panel display
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Access HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS)

To access the Embedded Web Server on any computer, open your Web browser and give the address
of your printer. You can find out the address of your printer (starting with http:) from the front-panel
display, by looking at the status screen.

If you have followed these instructions but failed to get through to the Embedded Web Server, see
Cannot access the Embedded Web Server on page 147.

Personalizing the printer

Change the language of HP Easy Printer Care (Windows)
or HP Printer Utility (Mac OS)
HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) can work in the following languages:
English, Portuguese, Spanish, Catalan, French, Italian, German, Russian, Simplified Chinese,
Traditional Chinese, Korean, and Japanese.
●

Under Windows, select Tools > Set Language and select a language from the list.

●

Under Mac OS, the language is changed as for any other application. In System Preferences
select International and re-launch the application.

Change the language of the Embedded Web Server
The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean, and
Japanese. It uses whichever language you have specified in your Web browser's options. If you have
specified a language that it cannot support, it works in English.
To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.
To complete the change, you must close and reopen your Web browser.

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep
mode to save power. The default is 30 minutes. To change the time the printer waits before it goes into
,
sleep mode, press the Menu key to return to the main menu and select the Setup menu icon
then Advanced > Sleep mode wait time. Highlight the wait time you want and then press the OK key.
You can set the time to 30, 60, 120, 150, 180, 210, or 240 minutes.
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Turn the buzzer on and off
To turn the printer's buzzer on or off, press the Menu key to return to the main menu and select the
, then Front panel options > Enable buzzer, and highlight on or off and press
Setup menu icon
the OK key. The default buzzer is set to on.

Change the front-panel display contrast
To change the contrast of the front-panel display, select the Setup menu icon
, then Front panel
options > Select display contrast, and enter a value using the Up or Down key. Press the OK key to
set the value. The default contrast is set to 50.

Change the units of measurement

Configure network settings
To configure the network settings from HP Easy Printer Care (Windows), select Settings tab > Network
Settings. From HP Printer Utility (Mac OS), select Configuration Group > Network Settings. You can
view and configure the following network settings.
●

IP Configuration method: specify the way to set an IP address between BOOTP, DHCP, Auto
IP, and Manual

●

Host name: specify an IP name for the network device, the name may contain up to 32 ASCII
characters

●

IP address: specify the IP address on the print server, duplicate IP addresses on a TCP/IP network
are not allowed
NOTE: If you change the current IP address and click Apply, the browser loses the current
connection to the print server because it is pointing to the old address. To reconnect, browse to
the new IP address.
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●

Subnet mask: specify a subnet mask, which is a 32-bit number applied to an IP address to
determine which bits specify the network and subnet and which bits uniquely specify the node

●

Default gateway: specify the IP address of a router or computer that is used to connect to other
networks or sub-networks, if none exist, use the IP address of the computer or the IP address of
the print server

●

Domain name: specify the name of the DNS domain that the print server resides in, for example,
support.hp.com, note that it does not include the host name; it is not the fully qualified domain
name, such as printer1.support.hp.com

●

Idle timeout: specify the number of seconds that an idle connection is allowed to remain open,
270 is the default value, if set to zero, the timeout is disabled and TCP/IP connections remain open
until closed by the other node (such as a workstation) on the network

●

Default IP: specify the IP address to use when the print server is unable to obtain an IP address
from the network when powered on or when reconfigured to use BOOTP or DHCP

●

Send DHCP requests: specify whether DHCP requests are transmitted when a legacy default IP
address or a default Auto IP is assigned

Turn the buzzer on and off
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To change the units of measurement in the front-panel display, select the Setup menu icon
,
then Advanced > Select units, and select English or Metric. By default the units are set to metric.

To configure the same network settings from the front panel, press the Menu key to go to the main menu
and select the Connectivity menu icon

, then Fast Ethernet > Modify configuration.

Change the graphic language setting
To be able to change the graphic language setting you must install the HP-GL/2 upgrade.
WARNING! You should not need to change the default graphic language setting (Automatic), and
you are not recommended to do so.
Change the graphic language setting from the HP Easy Printer Care and HP Printer Utility applications
with the following steps.
1.

Under Windows, select the Settings tab then Printer settings > Printing preferences.
Under Mac OS, select Configuration then Printer settings > Configure printer settings >
Printing preferences.

2.

Select one of the following options.

Personalizing the printer

●

Select Automatic to let the printer determine which type of file it is receiving. This setting
works for most software applications.

●

Select HP-GL/2 only if you are sending a file of the appropriate type directly to the printer,
without going through a printer driver.

You can change the graphic language setting from the front panel. Press the Menu key to return to the
main menu the select the Setup menu icon
option and press the OK key to set the value.

, then Select graphics language. Select the desired

NOTE: The setting selected through the HP Easy Printer Care (Windows) or HP Printer Utility (Mac
OS) overrides the setting select by the front pane.
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Paper handling

●

General advice

●

Choose which spindle to use

●

Load a roll onto the spindle

●

Load a roll into the printer

●

Unload a roll

●

Load a single sheet

●

Unload a single sheet

●

View information about the paper

●

Paper profiles

●

Add a custom paper type

●

Maintain paper

●

Change the drying time

●

Turn the automatic cutter on and off

●

Feed and cut the paper

Paper handling

4

ENWW

23

General advice
WARNING! Before starting a paper loading process, ensure you have enough room around the printer,
both in front and behind.

WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

WARNING! All paper must be 11 inches (28 cm) or longer. A4 and letter paper cannot be loaded
landscape.
TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

Paper handling

CAUTION: Keep the basket closed throughout the loading process.

Choose which spindle to use
Ensure you use the correct spindle. The illustrations in the Load a roll onto the spindle on page 25
procedure and the Load a roll into the printer on page 26 procedure show the black spindle. You must
use the gray spindle if you are loading the following categories and types of rolled papers wider than 36
in (91.5 cm).
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Paper category

Paper type

Bond and Coated Paper

Plain Paper

Bond and Coated Paper

Bright White Bond Paper

Bond and Coated Paper

Coated Paper

Chapter 4 Paper handling
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Paper category

Paper type

Technical Paper

Natural Tracing Paper

Technical Paper

Translucent Bond

Technical Paper

Vellum

TIP: If you are a regular user of different paper types, you can change rolls more quickly if you preload
rolls of different paper types on different spindles. Extra spindles are available for purchase, see
Accessories on page 103.

Load a roll onto the spindle
WARNING! Ensure the sheet tray is closed.

1.

Remove the right-hand end of the spindle from the printer, then the other end.

Paper handling

WARNING! Do not insert your fingers into the spindle supports during the removal process.

2.

ENWW

The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to
mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper
stop from the end of the spindle.

Load a roll onto the spindle
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3.

If your roll has a three-inch cardboard core, ensure that the core adaptors supplied with the printer
have been installed.

4.

If the roll is long; rest the spindle horizontally on a table and load the roll on the table.
TIP: You may need two people to handle a large roll.

5.

Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the
spindle showing the correct orientation.
NOTE:

From the back of the printer, the blue stopper is insert into the right-side holder.

Ensure both ends of the roll are as close to the spindle stops as possible.

Paper handling

6.

Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

7.

Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls
of different paper types on different spindles. Extra spindles are available for purchase, see
Accessories on page 103.

Load a roll into the printer
There are two ways to load a roll. The easy loading procedure is recommended.
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CAUTION: To start these procedures you must have a roll loaded on the spindle. See Load a roll onto
the spindle on page 25.

ENWW

1.

Check that you are using the correct spindle for your type of paper, see Choose which spindle to
use on page 24.

2.

Standing behind the printer, rest the spindle's black end on the left side roll holder. Do not put the
end completely into the roll holder.

3.

Rest the blue end of the spindle on the right side roll holder. If you are loading the gray spindle,
ensure the rounded side of the spindle top is resting on the roll holder.

4.

With both hands, push the spindle into both roll holders at the same time. The spindle snaps in
place.

Load a roll into the printer
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Paper handling

Easy loading procedure

5.

If the edge of the roll is torn (sometimes due to tape used to hold end of the roll) or not straight,
pull paper slightly beyond the cutting groove and use a cutter to cut a straight edge.

CAUTION:
6.

Cut the paper as straight as possible, as uneven paper does not load correctly.

Insert the edge of the paper into the feeder.
WARNING! Do not push your fingers inside the printer's paper path, the results may be painful.

Paper handling
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7.

Roll the spindle into the feeder until you feel resistance. The printer detects the paper and feed it
automatically into the printer.

8.

Once the paper is fed into the printer, the front-panel display asks if you are loading a roll or a
sheet. Select Roll with the Up and Down keys and press OK.

Chapter 4 Paper handling
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9.

Select your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list (neither in
the driver nor in the front panel), you can choose a generic paper name instead. For example, if
you are loading HP Aquarella Art Paper or Epson Smooth Fine Art Paper, and you don't find the
exact name in the paper list, you can choose Fine art paper.
10. The printer checks the alignment and measures the width.
11. Look at the front panel; you may find some instructions there.
12. When the roll is aligned, the front panel displays the Ready message and the printer is ready to
print. If the role is not aligned, follow the instructions on the front-panel display.

NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 114.
TIP: When prints fall into the basket, they can be torn or get ink marks from other prints. To avoid this,
catch your prints as they are cut from the roll and do not stack prints in the basket or turn off the automatic
cutter, see Turn the automatic cutter on and off on page 38, and use the Form feed and cut key to
release your print.

Paper menu procedure
As an alternative you can use the paper menu to start the paper loading process.
1.

Follow steps one through five of the Easy loading procedure on page 27.

2.
Press the Menu key to return to the main menu, select the Paper menu icon

ENWW

.

Load a roll into the printer
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13. If the paper is loose on the roll, lightly rewind from the end of the spindle until tight.

3.

Select Paper load.

4.

Select Load roll.

5.

Select your paper category and type.

Paper handling

TIP: If you have loaded a paper type whose name does not appear in the paper list (neither in
the driver nor in the front panel), you can choose a generic paper name instead. For example, if
you are loading HP Aquarella Art Paper or Epson Smooth Fine Art Paper, and you don't find the
exact name in the paper list, you can choose Fine art paper.
6.

Continue with step six of the easy loading process, skipping steps eight and nine.

TIP: When prints fall into the basket, they can be torn or get ink marks from other prints. To avoid this,
catch your prints as they are cut from the roll and do not stack prints in the basket or turn off the automatic
cutter, see Turn the automatic cutter on and off on page 38, and use the Form feed and cut key to
release your print.

Unload a roll
Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow
the appropriate procedure as described below.
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Unload paper key procedure with paper on the roll
If there is paper on the roll, use the following procedure.
1.

Press the Unload paper key on the front panel.

2.

When prompted by the front-panel display, lift the blue lever on the left.

3.

When prompted by the front-panel display, lightly rewind the paper from the end of the spindle until
removed from the printer.

4.

When prompted by the front-panel display, lower the blue lever.

Paper menu procedure with paper on the roll
If there is paper on the roll, you can also start the process from the paper menu in the front panel's main
menu.
1.
Press the Menu key to return to the main menu, select the Paper menu icon
2.

Select Unload paper.

3.

Continue from step two of the Unload paper key process.

.

If the end of the paper is no longer attached to the roll use the following procedure.
1.

If you have already started the unload process, press the Cancel key on the front panel to cancel
that procedure.

2.

Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3.

Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the
printer is recommended.

4.

Lower the blue lever.

5.

If the front panel displays a warning message, press the OK key to clear it.

Load a single sheet
There are two ways to load a sheet. The easy loading procedure is recommended.
CAUTION: Any loaded roll or sheet must be unloaded before loading a sheet, see Unload a roll
on page 30, and Unload a single sheet on page 35.
WARNING! For sheets thicker than 0.5mm, you must have space behind the printer equal to the length
of the sheet.

ENWW

Load a single sheet
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Roll out of paper procedure

Easy loading procedure
1.

Standing in front of the printer, open the sheet tray. If the sheet is long, extend the right extension.
If the sheet is also wide extend the left extension.
TIP: If the tray is difficult to open, try opening from behind the printer.

NOTE:
2.

The extensions are seven cm and snap in place.

Insert the sheet into the feeder. Load your sheet aligned with the load line and insert until the paper
will not continue, with thicker sheets you feel resistance. The printer detects the sheet in three
seconds. A countdown begins on the front-panel display.

Paper handling

WARNING! Take care not to push your fingers inside the printer's paper path, the results may
be painful.
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3.

After the countdown, the paper feeds into the printer. Guide the sheet into the printer; this is
especially important with thicker papers.

4.

The front-panel display asks if you are loading a roll or a sheet. Select Sheet with the Up and
Down keys.

Chapter 4 Paper handling
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5.

Enter your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list (neither in
the driver nor in the front panel), you can choose a generic paper name instead. For example, if
you are loading HP Aquarella Art Paper or Epson Smooth Fine Art Paper, and you don't find the
exact name in the paper list, you can choose Fine art paper.
6.

The printer checks the alignment and measures the sheet.

7.

If the paper has been loaded successfully, the front panel displays the Ready message and the
printer ready to print. If the paper is not straight, follow the instructions on the front-panel display.

NOTE:

When correctly loaded, the sheet is in the back of the printer.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper
cannot be loaded successfully on page 114.

Paper menu procedure
As an alternative you can use the paper menu to start the paper loading process
1.

ENWW

Perform step one of the easy loading procedure.

Load a single sheet
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NOTE: Depending on the length of the sheet, it feeds out the front of the printer.

2.
Press the Menu key to return to the main menu and select the Paper menu icon

3.

Select Paper load.

4.

Select Load sheet.

.

Paper handling
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5.

Select your paper category and type.

TIP: If you have loaded a paper type whose name does not appear in the paper list (neither in
the driver nor in the front panel), you can choose a generic paper name instead. For example, if
you are loading HP Aquarella Art Paper or Epson Smooth Fine Art Paper, and you don't find the
exact name in the paper list, you can choose Fine art paper.
6.

Continue with step two of the easy loading procedure, skipping steps four and five.

Unload a single sheet
To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.
To unload a sheet without printing, use the Unload paper key or the paper menu procedure.

Unload paper key procedure
1.

Press the Unload paper key on the front panel.

2.

The sheet unloads out the front of the printer, either catch it manually or allow it to fall in the basket.

Paper menu procedure
You can also unload a sheet from the paper menu.
Press the Menu key to return to the main menu and select the Paper menu icon

ENWW
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2.

Select Unload paper. The sheet unloads out of the front of the printer, either catch it manually or
allow it to fall in the basket.

View information about the paper
To view the loaded paper information, press the View loaded paper key on the front panel.
You can also select the Paper menu icon

and then View loaded paper.

The following information is displayed on the front panel:
●

Roll or sheet status

●

Paper manufacturer's name

●

Paper type you have selected

●

Width of the paper in millimeters (estimated)

●

Length of the sheet in millimeters (estimated)

●

Color calibration status

If no paper is loaded, the message Out of paper is displayed.

Paper handling

The same information (apart from the manufacturer's name) is displayed in HP Easy Printer Care and
HP Printer Utility on the Supplies page.
NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 128.

Paper profiles
Each supported paper type has its own characteristics. For optimum print quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the “media” or “paper” profile. The paper profile contains the ICC
profile, which describes the color characteristics of the paper; it also contains information on other
characteristics and requirements of the paper that are not directly related to color. Existing paper profiles
for your printer are already installed in the printer's software.
However, as it is inconvenient to scroll through a list of all paper types available, your printer only
contains paper profiles for the most commonly used paper types. If you have a paper type for which
your printer has no profile, you cannot select that paper type in the front-panel display.
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There are three ways to assign a profile for a new paper type.
●

Use a HP factory paper profile by selecting the closest category and type in the front panel, HP
Easy Printer Care (Windows), or HP Printer Utility (Mac OS)
NOTE: Colors may not be accurate. This method is not recommended for high-quality prints.

●

Download the correct paper profile from: http://www.hp.com/go/designjet/downloads
NOTE: HP only provides profiles for HP paper types. If you do not find the paper profile you want
on the Web, you may find that it has been added to the latest firmware for your printer. You can
check the firmware release notes for information, see Update the firmware on page 100.

●

Add custom paper type, see Add a custom paper type on page 37, and create an ICC profile,
this works for both HP and non-HP papers

Add a custom paper type
Before you can use a custom paper with your printer you must add a custom paper type and allow the
printer to run a color calibration. You can add a custom paper using the HP Color Center in HP Easy
Printer Care (Windows) or HP Printer Utility (Mac OS).
NOTE: If you have already selected Custom paper > Add Custom Paper from HP Easy Printer Care
(Windows) or HP Printer Utility (Mac OS), the first Add New Paper screen appears and you can start
this procedure at step four.
1.

Go to the Color Center in HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS).

2.

Select Manage Papers.

3.

In Windows, select Add new paper. In Mac OS, click +.

4.

Enter your paper's name.
NOTE: It is recommended to use the paper's commercial name to avoid confusion for other users.
Select a paper category.
NOTE: The paper category determines the amount of ink used and other basic printing
parameters. To obtain satisfactory results, experiment with different categories and use the ones
that work best.

6.

Load your custom paper, see Load a roll into the printer on page 26 or Load a single sheet
on page 31.

7.

Click Next. The printer performs a color calibration and prints a calibration chart. This may take
ten minutes.
NOTE: For more information on the processes available in the Color Center, see A summary of
the color management process on page 57.

ENWW

8.

Once the new calibration parameters are calculated and stored, you are reminded to create an ICC
profile. Click Done. Your custom paper is added to the paper category you selected.

9.

To create an ICC profile, which allows you to print on your paper with the best possible color
accuracy, see Color profiling on page 59.

Add a custom paper type
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Maintain paper
To maintain paper quality, follow the recommendations below.
●

Store rolls covered by another piece of paper or cloth

●

Store cut sheets covered and clean or brush them before loading them in the printer

●

Clean input and output platens and cut sheet tray

●

Always keep the transparent window of your printer closed

NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 128.

Change the drying time
You may wish to change the drying time setting to suit special printing conditions such as multiple prints
where time is of higher importance or when you need to be sure ink is dry before handling.
Select the Setup menu icon

, then Print retrieval> Select drying time. You can select:

●

Extended, to set a longer than recommended time to ensure ink is completely dry

●

Optimal, to set the default and recommended time for your selected paper

●

Reduced, to set a shorter than recommended time when quality is of lower importance

●

None, to disable the drying time and remove your print as soon as it finishes printing

WARNING! If the ink is not dry when the print is removed it could leave ink in the output tray and marks
on the print.

Paper handling

NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right
away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts
the paper and then performs the printhead maintenance. However, if the dry time is greater than zero,
the printer does not cut the paper until after the printhead maintenance has completed, even if the Form
feed and cut key has been pressed.

Turn the automatic cutter on and off
To turn the printer's paper cutter on or off:
●

From HP Easy Printer Care (Windows), select the Settings tab and change the Cutter option in
Printer Settings > Advanced.

●

From HP Printer Utility (Mac OS), select Configuration > Printer Settings > Configure Printer
Settings and change the Cutter option.

●

From the Embedded Web Server, select the Setup tab, then Printer Settings, and change the
Cutter option.

●

Press the Menu key to return to the main menu, select the Setup menu icon
retrieval > Enable cutter.

, and then Print

NOTE: To cut rolled paper while the automatic cutter is disabled, see Feed and cut the paper
on page 39.
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Feed and cut the paper
To feed and cut the paper when the automatic cutter has been disabled, press the Form feed and cut
key on the front panel. The paper advances and the printer makes a straight cut on the front edge.
NOTE: The printer may not cut the paper directly after the Form feed and cut key is pressed, as each
time a print is printed the printheads are serviced and the paper cannot be cut until the process
completes.
Remove the cut piece from the output tray.

WARNING! If strips or short prints are left in the output tray the printer could jam.

Paper handling

NOTE: Photo and coated paper requires careful handling, see The print is scuffed or scratched
on page 128.
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Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed,
while fast printing implies some reduction in print quality.
Therefore, the standard print-quality selector is a slider that allows you to choose between quality and
speed.
Alternatively, you can select from the custom options: Best, Normal, and Fast. There are also two
supplementary custom options that may have an effect on print quality: Maximum detail and More
passes. See High-quality printing on page 48.
NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom
Print Quality Options dialog box. In the Mac OS Print dialog, it is displayed in the Summary panel.
You can select print-quality options in the following ways:
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
If you select Standard Options, you will see a simple slider with which you can select speed or
quality. If you select Custom Options, you will see the more specific options described above.

●

In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper. If you
select Standard quality options, you will see a simple slider with which you can select speed or
quality. If you select Custom quality options, you will see the more specific options described
above.

●

, then Printing preferences > Print
Using the front panel: select the Setup menu icon
quality. This option is available only with the HP-GL/2 Upgrade.
NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the
front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Select paper size
The paper size can be specified in the following ways.
NOTE: The paper size specified here should be the paper size in which the document was created.
It is possible to rescale the document to a different size for printing. See Rescale a print on page 44.
●

In the Windows driver dialog: select the Paper/Quality tab, then Document Size.

●

In the Mac OS Page Setup dialog: select your printer in the Format for popup menu, then Paper
Size.

●

, then Printing preferences > Paper >
Using the front panel: select the Setup menu icon
Select paper size. This option is available only with the HP-GL/2 Upgrade.

Printing
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To choose a non-standard paper size not shown in the list of paper sizes:
●

Under Windows, there are two different ways:
◦

In the driver dialog, select Custom from the paper size list in the Paper/Quality tab, then
specify the paper dimensions, then click Save to save your new paper size. To see your new
custom size in the list of custom sizes, you need to exit the printer properties, then reenter
them and use the More button.

◦

From the Start menu, select Printers and Faxes, then from the File menu select Server
Properties. In the Forms tab, check the Create a new form box, specify the name and
dimensions of the new form, then click Save Form.

●

Under Mac OS X 10.4, select Paper Size > Manage Custom Sizes in the Page Setup dialog.

●

Under Mac OS X 10.2 or 10.3, select Settings > Custom Paper Size from the Page Setup dialog.

Select margins options
By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the
paper (17 mm at the foot of a sheet of paper). However, you can change this behavior in several ways.
●

In the Windows driver dialog: select the Paper/Quality tab and then the Layout button.

●

In the Mac OS Print dialog: select the Paper Type/Quality panel and then Layout.

You will then see at least some of the following options.

●

Standard. Your image will be printed on a page of the size you have selected, with a narrow margin
between the edges of the image and the edges of the paper. The image should be small enough
to fit between the margins.

●

Oversize. Your image will be printed on a page slightly larger than the size you have selected. If
you cut off the margins, you will be left with a page of the size you selected, with no margins
remaining between your image and the edges of the paper.

●

Clip Contents By Margins. Your image will be printed on a page of the size you have selected,
with a narrow margin between the edges of the image and the edges of the paper. In this case, if
the image is the same size as the page, the printer assumes that the extreme edges of the image
are either white or unimportant, and do not need to be printed. This may be useful when your image
already contains a border.

●

Borderless. Your image will be printed on a page of the size you have selected, with no margins.
The image is slightly enlarged to ensure that no margin is left between the edges of the image and
the edges of the paper. If you select Automatically by Printer, this enlargement is done
automatically. If you select Manually in Application, you must select a custom page size slightly
larger than the page on which you intend to print. See also Print with no margins on page 49.

Print with shortcuts
The printer driver provides many options that can be set to different values when printing a particular
job. A printing shortcut stores the values of all these options that are appropriate for a particular kind of
job, so that you can set them all with a single click. Some settings (such as paper size, paper source,
and orientation) may be overridden by the values provided by your application.
To use a shortcut, select the Printing Shortcuts tab in the Windows driver dialog.
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NOTE: Under Mac OS, the available margins options depend on the paper size selected in the Page
Setup dialog. For instance, for borderless printing you must select a paper size name that includes the
words “no margins”.

NOTE: Shortcuts are available only under Windows.

You can see a list of available shortcuts; select the one that matches the kind of job you want to print.
The driver options are now adjusted to suit your job. You can either print immediately, or examine the
settings to check that you agree with them. If you like, you can select a shortcut and then change some
of its settings manually.
TIP: Check at least the settings that you can see in the Printing Shortcuts tab: the document size,
orientation, etc.
The Factory Defaults shortcut contains the printer's default settings. When you click on it, it sets all
options to their default values.
Printing shortcuts can be customized to your particular needs. To create your own shortcut:
1.

Select the shortcut that comes closest to satisfying your requirements.

2.

Change any value in the Printing Shortcuts tab and/or other tabs.

3.

Save the new printing shortcut.

If you decide later that you no longer want a shortcut, you can delete it.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:

Printing
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●

If your software does not support large formats

●

If your file is too large for the printer's memory—in this case, if you have the HP-GL/2 Upgrade,
you can reduce the paper size in your software and then scale it up again using the front-panel
option

Chapter 5 Printing

ENWW

You can rescale an image in the following ways:
●

●

●

In the Windows driver dialog: select the Effects tab, then Resizing options.
◦

The Print document on option adjusts the image size to the paper size you have selected.
For example, if you have selected ISO A2 as the paper size and you print an A4-size image,
it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a
larger image to fit the A3 size.

◦

The % of normal size option enlarges the printable area of the original paper size (the page
minus the margins) by the percentage indicated, then adds the margins to create the output
paper size.

In the Mac OS Print dialog: select the Paper Handling panel, then Scale to fit paper size, and
select the paper size to which you want to scale the image. If you want to increase the size of the
image, make sure that the Scale down only box is unchecked.
, then Printing preferences > Paper >
Using the front panel: select the Setup menu icon
Scale. This option is available only with the HP-GL/2 Upgrade.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet,
otherwise the image will be clipped.

Change the treatment of overlapping lines
NOTE:

This topic applies only when printing an HP-GL/2 job with the HP-GL/2 Upgrade.

The merge option controls the overlapping lines in an image. There are two settings:
●

Off: where the lines cross, only the color of the top line is printed.

●

On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and select the Setup menu icon
, then Printing
preferences > HP-GL/2 > Enable merge. You can set the merge option from your software in some
applications. Settings in your software override the front-panel settings.

Preview a print
Previewing a print on the screen allows you to check the layout of the print before printing, which may
help you to avoid wasting paper and ink on a bad print.
●

To preview a print under Windows, you have two options:
Use your application's print preview option.

Printing
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◦

●

Check the Show preview before printing option, which you can find in the driver's Printing
Shortcuts tab, Paper/Quality tab, and Features tab. The preview is shown before printing;
you can check the print settings and the layout of the image, and then click Print to proceed
with printing or Cancel to cancel the job.

To preview a print under Mac OS, you have three options:
◦

Use your application's print preview option.

◦

Click the Preview button at the bottom of the Print dialog box. This is the basic print preview
provided by Mac OS.

Printing
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◦

Click the PDF button at the bottom of the Print dialog box, then click HP Print Preview. This
provides a preview with more features, such as the ability to change paper size, paper type,
and print quality, and to rotate the image. See below:

NOTE: HP Print Preview is not available if you are using Adobe InDesign, Adobe Illustrator,
Adobe Reader, or Apple Aperture.

Print a draft
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme left ('Speed').

●

In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then move
the print-quality slider to the extreme left ('Speed').

●

, then Printing preferences > Print
Using the front panel: select the Setup menu icon
quality > Select quality level > Fast. This option is available only with the HP-GL/2 Upgrade.

NOTE:
panel.
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You can specify fast draft-quality printing in the following ways:

High-quality printing
You can specify high-quality printing in the following ways:
●

In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section.
Move the print-quality slider to the extreme right ('Quality').

●

In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Paper, then move
the print-quality slider to the extreme right ('Quality').

●

, then Printing preferences > Print
Using the front panel: select the Setup menu icon
quality > Select quality level > Best. This option is available only with the HP-GL/2 Upgrade.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the front
panel.

If you have a high-resolution image
If your image has a resolution greater than the rendering resolution (which you can see in the Custom
Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum
Detail option.
●
●

In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality options,
then check the Maximum Detail box.
, then Printing preferences > Print quality
In the front panel: select the Setup menu icon
> Enable maximum detail. This option is available only with the HP-GL/2 Upgrade.

NOTE: The Maximum Detail option results in slower printing with photo papers, but it does not increase
the amount of ink used.

If you have printhead problems
If your printheads have an excessive number of clogged nozzles, print quality is improved by selecting
the More Passes option.
●
●

In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality options,
then check the More Passes box.
, then Printing preferences > Print quality
In the front panel: select the Setup menu icon
> Enable more passes. This option is available only with the HP-GL/2 Upgrade.

NOTE: The More Passes option results in slower printing, but it does not increase the amount of ink
used.
TIP: Instead of using this option, consider using the Image Diagnostics Print to identify the printhead
or printheads that are causing the problem, and then clean or replace them. See The Image Diagnostics
Print on page 133.

Printing
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Print in gray shades
You can convert all colors in your image to shades of gray in the following ways:
●

In your application program: many programs provide this option.

●

In the Windows driver dialog: go to the Color tab and look at the Color Options section.
Select Print In Grayscale.

●

In the Mac OS Print dialog: go to the Paper Type/Quality panel and select Color, then select
Print In Grayscale.

If you select Print In Grayscale when using glossy paper, you must also choose between Gray and
Black inks only and Full set of inks.
●

Gray and Black inks only means that only gray and black inks are used in your grayscale print.
This gives the most neutral shades of gray and is selected by default for all paper types.

●

Full set of inks means that a mix of different colors are used in your grayscale print. This may give
a better result if you are experiencing bronzing on glossy paper with the Gray and Black inks
only option. See Bronzing on page 130.

See also Print a black-and-white photo for an exhibition (Photoshop, Mac OS) on page 67.

Print with no margins
Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done
only on rolls of glossy paper.
In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink
deposited outside the paper is absorbed by the sponge situated in the platen.
You can request printing with no margins in the following ways:
●

In the Windows driver dialog: select the Paper/Quality tab and press the Layout button. Then
select Borderless.

●

In the Mac OS Page Setup dialog: select a paper size name that includes the words “no margins”.
Then, in the Print dialog, select Paper Type/Quality > Layout > Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:
●

Automatically by Printer means that the printer automatically enlarges your image slightly
(normally by a few millimeters in each direction) in order to print over the edges of the paper.

●

Manually in Application means that you must enlarge the image yourself in your application, and
select a custom paper size that is slightly larger than the actual paper size.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure
that the print is borderless. It then cuts the paper again so that no residual part of the image is included
in the next print. However, if the job is cancelled, or if there is white space at the bottom of the image,
only a single cut is made.

Reprint an old job
You can reprint an already-printed job from the front panel, if you have the HP-GL/2 Upgrade and it is
an HP-GL/2 job.
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NOTE: If the first print job after loading paper is a borderless job, the printer may trim the leading edge
of the paper before printing.

Select the Job Queue menu icon

, then select the job from the queue, then select Reprint.

NOTE: If you do not have the HP-GL/2 Upgrade, you will not see the Job Queue menu icon

.

To reprint old jobs that are not HP-GL/2, you may be able to use your operating system's printer spooler,
if you have already told the spooler to save old jobs. This facility depends on your operating system.

Use paper economically
Here are some recommendations for making economical use of paper:
●

If you are printing relatively small images, you can print up to 16 of them on one sheet of paper.
Use the Pages per sheet option in the Features tab (Windows driver) or the Layout panel (Mac
OS driver).
NOTE:

●

●

This works for multipage documents only.

You may be able to save some roll paper by using the following options:
◦

In the Windows driver dialog: select the Features tab and then Remove Top/Bottom Blank
Areas or Rotate by 90 degrees.

◦

In the Mac OS Print dialog: select the Paper Type/Quality panel, then Paper, then Remove
Top/Bottom Blank Areas.

If you check the print preview on your computer before printing, you can sometimes avoid wasting
paper on prints containing obvious mistakes. See Preview a print on page 45.

Use ink economically
Here are some recommendations for making economical use of ink.
●

For draft prints, use plain paper and move the print-quality slider to the left end of the scale
('Speed').

●

Clean the printheads only when needed, and clean only those printheads that need cleaning.
Cleaning the printheads can be useful, but it uses ink.

●

Leave the printer permanently turned on so that it can maintain the printheads in good condition
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not
done, the printer may need to use much more ink later to restore the health of the printheads.

●

Wide prints make more efficient use of ink than narrow prints, because printhead maintenance
uses some ink, and its frequency is related to the number of passes made by the printheads.

Printing
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What is color?
We see the world around us as steeped in color, where color is in the first instance simply an aspect of
how we experience our environment. Color is therefore subjective. Upon further inspection we find that
our color experiences are closely related to brain activity that is triggered by signals sent to it by our
eyes. These signals undergo a complex and highly interlinked sequence of processing stages that make
the relationship between what our eyes emit and what we experience anything but direct. The signals
sent by the eye depend on the light-sensitive cells that line the back of our eyes, and they belong to
three types, each sensitive to electromagnetic radiation of different physical properties (wavelengths).
Such electromagnetic radiation is called light and objects appear to have certain colors because of how
they interact with light (by emission, reflection, absorption, transmission, scattering, etc.).
Our individual experiences of color are also affected by our previous experiences and memories and
by the way in which we put our experiences into language. Finally, environmental factors such as
changes in lighting, scene content, or the proximity of other colors also have an effect, which makes the
way in which we view a given display or print an essential part of the colors we will see. Differences in
all these aspects (from physiological differences between people, to differences in their past
experiences, memories and linguistic tendencies) can result in people talking about colors differently
even in response to the same light reflected from an single object. Nonetheless there are also many
similarities between how individuals experience color and it is possible to make very specific judgments
about it that others will also agree with when care is taken in the process. In conclusion we can say that
color results from the interaction between light, objects, and a viewer, which makes it a very complex
and to a large degree subjective phenomenon.

The problem: color in the computer world
Color imaging devices such as printers, displays, projectors, and televisions create colors by different
means and by using different materials (colorants). Displays, for instance, use colorants that emit red
(long wavelength), green (medium wavelength) and blue (short wavelength) light, where outputting a
white color requires the full use of all three colorants and black requires that none of them be used (i.e.
that no light be emitted). Devices that use light emitting colorants are called additive, because the light
from them is added together before it enters a viewer’s eyes. Printers, on the other hand, use materials
that absorb parts of the light that shines on them and because of this absorption, they are called
subtractive. Typical prints use cyan (red absorbing), magenta (green absorbing) and yellow (blue
absorbing) inks as well as an additional black ink that absorbs light at all wavelengths. To get white
using a printer requires not absorbing any of the light that illuminates a piece of paper and to get black,
all of the inks need to be used to absorb all of the light that is present.
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●

RGB (Red, Green, and Blue) is the color space typically used for additive devices. A color is
represented as a combination of specific quantities of red, green, and blue colorants and all such
combinations address the range of colors (color gamut) of the chosen device.
NOTE: Subtractive devices can also be controlled using RGB data and, especially when you do
not require control over how you want to use your printer’s black ink, this is an efficient option.

●

CMYK (Cyan, Magenta, Yellow, and Black) is the color space for subtractive devices, such as
printers or presses. A color is represented as a combination of cyan, magenta, yellow, and black
(K) inks and all such combinations let you address the entire range of colors of the chosen device.

Both of these color spaces are only ways of controlling different color imaging devices and their values
do not describe colors directly. The same CMYK values, for example, will give different colors when
sent to different printers that use different inks and paper types. For example, consider a printer that
can use indoor inks or outdoor inks. The printer (hardware) is the same, but it has two different color
gamuts due to the different chemistry of the inks (dye-based versus pigmented). Furthermore, they need
to work with different paper types, as ink interaction with the paper depends on its chemistry. Thus, the
colors resulting from given CMYK values depend on the types of inks and papers that you use with a
printer. If this is the case using the same printer, you can easily imagine how different results can be
obtained with printers using different technologies and therefore using different ink chemistry.
The same happens with RGB-controlled devices. For example, imagine that two different monitors from
the same manufacturer have their white points at 9600 K and 6500 K respectively. Their colors are going
to be different because they will be related to a different white point reference. The situation is even
worse when comparing monitors from different manufacturers. As a recommendation, set the white point
of your monitor to 5000 K (also called D50), since this is the standard color temperature for the graphic
arts industries. If you dislike the appearance of D50 (you may find it too yellowish), the second choice
is to set the display to 6500 K (D65).
NOTE: The white point is the brightest neutral color that a device can reproduce or that is present in
an image. The human visual system automatically adapts to the content of an image with respect to its
white point.
Furthermore, an RGB image, such as an image obtained from a digital camera and edited on a monitor,
needs to be first converted to CMYK for a specific printer before printing. Unfortunately different devices
do not give access to the same color gamuts: there are some colors that can be shown on a display
that cannot be matched in print and vice versa. The following graphic illustrates how colors visible to
the human eye are greater than those reproduced by a typical display or printer using a specific paper
type and also how the color gamuts accessible using these two color imaging devices do not match
each other.
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To control the output of color imaging devices, the following color spaces are normally used:

Color management
1.

All colors

2.

Computer monitor gamut

3.

CMYK press gamut

Finally, there are some color spaces that are not device-dependent, but instead represent how a viewer
sees colors, such as CIE Lab or CIECAM02 defined by the CIE (Commission Internationale de
l’Éclairage). The advantage of these spaces is that, unlike CMYK or RGB, if two objects have the same
CIE Lab values then they will look the same when viewed under the same conditions. Values in these
spaces can be obtained from measuring the light emitted or reflected by an object.

The solution: color management
There are many colors from an RGB-controlled device that can no be reproduced in a CMYK-controlled
device and vice versa. These colors are called “out-of-gamut” colors. The industry uses two steps to
reduce color differences as much as possible:
●

Describe the color behavior of each device as accurately as possible

●

Convert one color gamut to another as effectively as possible

The solution:
1.

Describe the color behavior of a device as accurately as possible using an ICC profile. By
taking various RGB or CMYK combinations, sending them to a device, measuring the resulting
output and expressing it in a device-independent color space (e.g. CIE Lab), the color behavior of
a device can be described. The resulting relationship is stored in an ICC profile, which is a standard
file that acts as a dictionary to translate the device’s color space (CMYK or RGB) to a deviceindependent color space (e.g. CIE Lab). The process of generating an ICC profile is called profiling.

2.

Convert colors as effectively as possible using a Color Management System (CMS). A CMS
is software that uses information from ICC profiles to transform one device’s color space (defined
by a source profile) into the color space of another device (defined by a destination profile). The
difficult part of the job is with those colors that exist in one device’s gamut but not in the other. We
will explore this in more detail later on.

Briefly, we can describe any CMS by the following 4 settings:
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●

CMS: CMS stands for Color Management System. It is the application that converts the color
information stored in the input image, which has the color space defined by a source profile, into
an output image that has the color space specified by a destination profile. There are many different
CMSs on the market: there are CMSs in applications, in operating systems, and in printing software
provided by printer manufacturers (in our case the HP Designjet Z2100 internal RIP).

●

Source profile: a description of the color behavior of the input device.

●

Destination profile: a description of the color behavior of the output device.

●

Rendering intent: the most difficult challenge in color management is when a color in the source
gamut does not correspond directly to a color in the destination gamut. As a perfect match is not
possible, there are different types of choices that can be made about how to treat gamut differences
and these are called rendering intent. There are four different possibilities depending on the final
output you want to achieve.
◦

Use Perceptual for the most pleasing final output from your original RGB image. It is suitable
for photographic content.

◦

Use Saturation for vivid final output. It is suitable for business graphics (charts, presentations,
etc.), but is not recommended for color matching.

◦

Use Relative Colorimetric for press proofing. This rendering intent provides a match for
colors that are inside both the source and destination gamuts and minimizes differences when
a match is not possible.

◦

Use Absolute Colorimetric for press proofing (like Relative Colorimetric), when you also
want to simulate the color of the source’s paper.

The most commonly used device color spaces and, therefore, profiles are:
●

ENWW

RGB mode:
◦

sRGB (sRGB IEC61966-2.1): for images originating typically from consumer digital cameras
and scanners and in general from the Web

◦

Adobe RGB (1998): for images originating typically from professional digital cameras

◦

Specific RGB device space: for images coming from or going to a specific RGB device that
has been profiled. The HP Designjet Z2100 has the capability to measure itself and generate

The solution: color management
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an RGB ICC profile, describing its color behavior for the paper that was loaded at the time of
measuring.
●

CMYK mode:
◦

SWOP: abbreviation of “Specifications for Web Offset Publications”, a set of press standards
defined for a typical US press and for different types of paper

◦

ISO 12647-2: a set of press standards defined by the International Standards Organization
for different types of paper (Coated, Uncoated, …)

◦

Other regional standards: Euroscale, JMPA, Japan Color

◦

Specific CMYK device space: for images coming from or going to a specific CMYK device
that has been profiled

Color and your printer
As a creative professional, predictable and dependable results from your printer are essential to getting
your job done. Predictability is a key element of an efficient color workflow. You need prints that match
your expectations with neutral grays and correct colors on your selected paper. Your prints should be
produced consistently print-to-print and printer-to-printer. Dependability ensures that every print is free
of print-quality defects and ready to use or send to your customer. You save time and effort and avoid
wasting ink and paper, and you can meet demanding production schedules by printing overnight with
confidence.
HP Designjet Z2100 printers have been engineered with advanced hardware and driver features to
ensure predictable and dependable results, and offer dramatic improvements in efficiency and control
for your color workflow.

HP Embedded Spectrophotometer
HP Designjet Z2100 printers revolutionize professional color workflows by using a built-in
spectrophotometer for color calibration and profiling.
A spectrophotometer is a precision instrument that can determine the exact composition of light reflected
from a color patch. It splits the reflected light into different wavelength components, just as Newton’s
prism splits white light into the colors of the rainbow, and measures the strength of each component.
The HP Embedded Spectrophotometer is mounted on the printhead carriage.
The spectrophotometer allows HP Designjet Z2100 printers to generate custom ICC profiles
automatically for your preferred paper types and calibrate the printers to deliver print-to-print and printerto-printer repeatability with less than half the color error of earlier HP Designjets, under all environmental
conditions, and even on unknown (not factory-profiled) paper types. A built-in white calibration tile,
protected by an automatic shutter, ensures reliable measurements that meet international standards.
The printer, color imaging pipeline, and professional-quality spectrophotometer with GretagMacbeth i1
color technology are integrated with the HP Color Center software for the HP Designjet Z2100. Giving
the calibration and profiling processes direct access to the writing system allows precise control of ink
levels and color separations for each printed color patch. The automated measurement process
eliminates handling the test print, provides repeatable drying times, and allows fast measurements with
precise electromechanical positioning of the spectrophotometer over the color patch. This provides
unprecedented ease of use and matches or exceeds the performance of more expensive off-line,
handheld profiling systems.
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To get the accurate and consistent colors that you want, you should follow these steps for each paper
type that you use.
1.

If your paper type is not already known to the printer, add it to the printer's list of known papers.
Typical users may add a few custom paper types every year.

2.

Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and
then, when recommended by a printer alert (typically, every few weeks for each paper type you
use). In addition, you may wish to calibrate immediately before a particularly important print job for
which color consistency is vital.

3.

Color-profile the paper type, for accurate colors. Profiling does not normally need to be repeated:
once you have a profile for a particular paper type, you can continue to use it. However, re-profiling
does no harm, and some users repeat the profiling process every month to ensure that the profile
is up to date.

4.

When printing, select the correct color profile for the paper type you are using.

If you use a paper type already defined in the printer, it has a color profile already, but you should at
least calibrate it before using it.
If you define a new paper type, you are automatically led through the steps of calibration and profiling.
The following diagram shows the operations handled by the HP Color Center, in the correct order.

NOTE: You can perform all three operations in sequence as shown, but you can also choose to start
with or stop after any of the three operations. With one exception: color calibration is performed
automatically after adding a new paper type.
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A summary of the color management process
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Color calibration
Color calibration enables your printer to produce consistent colors with the particular printheads, inks,
and paper type that you are using, and under your particular environmental conditions. After color
calibration, you can expect to get identical prints from any two different printers situated in different
geographical locations.
Calibration should be done in any of the following circumstances:
●

Whenever a printhead is replaced

●

Whenever a new paper type is introduced that has not yet been calibrated with the current set of
printheads

●

Whenever a certain amount of printing has been done since the last calibration

●

Whenever the printer has been turned off for a long period of time

●

Whenever the environmental conditions (temperature and humidity) change significantly

The printer usually reminds you with an alert whenever you need to perform color calibration, unless
you have disabled the alerts. However, if the environmental conditions change, the printer will not be
aware of it.
You can check the color calibration status of the currently loaded paper at any time by pressing the
View loaded paper key on the front panel. The status may be one of the following:
●

PENDING: the paper has not been calibrated.
NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is
reset to PENDING.

●

OBSOLETE: the paper has been calibrated, but the calibration is now out of date for one of the
reasons mentioned above, and should be repeated.

●

DONE: the paper has been calibrated, and the calibration is up to date.

●

DISABLED: this paper cannot be calibrated.
NOTE: Color calibration cannot be performed on plain paper, nor on any kind of transparent
material.

You can also check the color calibration status by using HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS).
You should calibrate a paper type before creating its color profile; however, you can later recalibrate
without needing to recreate the color profile.
You can start color calibration in the following ways:
●

From the printer alert that recommends calibration.

●

From the HP Color Center: select Calibrate Your Printer.

●

From the front panel: select the Image Quality Maintenance menu icon
color.

, then Calibrate

The calibration process is fully automatic and can be performed unattended after you have loaded paper
of the type you wish to calibrate—which should be A4, Letter, or any larger size.
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The process takes about 8–10 minutes and consists of the following steps.
1.

A calibration test chart is printed, which contains patches of each ink used in your printer.

2.

The test chart is allowed to dry for a period of time that depends on the paper type, so that the
colors have time to stabilize.

3.

The test chart is scanned and measured using the HP Embedded Spectrophotometer.

4.

From the measurements made by the spectrophotometer, the printer calculates the necessary
correction factors to apply for consistent color printing on that paper type. It also calculates the
maximum amount of each ink that can be applied to the paper.

Color profiling
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For
instance, if your printer prints all colors as black, its colors may be consistent but they are not accurate.
In order to print accurate colors, it is necessary to convert the color values in your files to the color values
that will produce the correct colors from your printer, your inks, and your paper. An ICC color profile is
a description of a printer, ink, and paper combination that contains all the information needed for these
color conversions.
When you have defined and calibrated a new paper type, the printer is ready to create a ICC profile for
use with your paper, which will allow you to print on it with the best possible color accuracy. Alternatively,
if your paper type is already known to the printer, you already have an appropriate ICC profile for use
with it.

Create your own profile
You can create a color profile easily by using the HP Color Center: select Create and Install ICC
Profile. The printer helps you by prompting for information about the paper, then creates and installs
the new profile automatically.
The process takes about 15–20 minutes and consists of the following steps.
1.
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A profiling test chart is printed, which contains patches of each ink used in your printer. Unlike a
calibration test chart, most of the patches contain combinations of more than one ink.

Color profiling
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The printer chooses automatically between two profile charts:

2.

●

An A3 or B format for cut sheets

●

A roll-paper format that minimizes paper use by printing across the full width of the roll

The test chart is allowed to dry for a period of time that depends on the paper type, so that the
colors have time to stabilize.
NOTE: If you would like to use a longer drying time, you can ask the HP Color Center to create
the test chart without going on to create a profile (Windows: Print target only; Mac OS: Print ICC
profiling chart). Then, later, when the chart is completely dry, you can restart the HP Color Center
and ask it to create a profile using the test chart you have already created (Windows: Create ICC
profile from a target that has already been printed; Mac OS: Scan ICC profiling chart and
create ICC profile). In this case the spectrophotometer takes a while to warm up before it is ready
to scan.

3.

The test chart is scanned and measured using the HP Embedded Spectrophotometer.

4.

From the measurements made by the spectrophotometer, the printer calculates the ICC profile for
your printer, inks, and paper type.

5.

The new ICC profile is stored in the correct system folder on your computer, where your application
programs can find it.
The profile is also stored in the printer, so that other computers connected to the same printer can
copy it. HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) will notify you if your printer
has profiles that are not yet stored on your computer.

NOTE: Some applications may need to be closed and restarted in order to use a profile that has just
been created.
You can profile a photo paper with the gloss enhancer on or off. The two profiles will be different, so you
are recommended to save them under different names.

Use a third-party profile
If you have obtained an ICC profile through other means than using the printer’s built-in profiling
software, for instance from an Internet download or a third-party profiling software package, you can
install it for use with your printer and paper.
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The printer requires RGB output profiles.

The printer needs to know which paper type the profile corresponds to, so you must first select a paper
type from the list of papers it knows about. When choosing a paper type, try to pick one resembling your
actual paper type as closely as possible. The paper type determines the amount of ink to use and other
basic printing parameters, so making a good choice here is fundamental to achieving good results later
on. If you find that you cannot obtain satisfactory results with the profile and paper type you picked, you
can experiment with choosing different types for new paper names corresponding to the same paper,
and use the one that works best.
If the paper you are using is not listed, or you cannot find a paper type that resembles yours closely
enough, you can define a new type. The printer then calibrates itself for use with your paper, after which
you can return to installing the ICC profile.
After you have selected the paper type, browse to the file containing the ICC profile to use with your
printer and paper. Normally, ICC profile file names end in the “.icc” (for International Color Consortium)
or “.icm” (for Image Color Matching) extension. The profile will be stored in the correct system folder on
your computer, and in the printer, as usual.

Profile your monitor
You are also recommended to calibrate and profile your monitor (display device), so that the colors you
see on the screen are more closely related to those you see on your prints. There are two ways to do
this:
●

Use the facilities provided with your operating system. From the HP Color Center, select How To
Calibrate Your Display for further information.

●

Use the HP Advanced Profiling Solution, which will give more accurate results.

Advanced profiling
To meet advanced color profiling needs, HP offers an optional Advanced Profiling Solution with software
and monitor-calibration hardware at much lower cost than competing solutions.

Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that,
when you print an image, you see very similar colors as when you view the same image on your monitor.
There are two basic approaches to color management for your printer:
●

Application-Managed Colors: in this case your application program must convert the colors of
your image to the color space of your printer and paper type, using the ICC profile embedded in
the image and the ICC profile of your printer and paper type.

●

Printer-Managed Colors: in this case your application program sends your image to the printer
without any color conversion, and the printer converts the colors to its own color space using a set
of stored color tables. ICC profiles are not used. This method is somewhat less versatile and
adaptable than Application-Managed Colors, but it is a little simpler and faster, and can produce
good results with standard HP paper types.
NOTE: There are only two color spaces that the printer can convert to its own color space using
the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB and
ColorSync if you are using Mac OS.
ColorSync is the Mac OS built-in Color Management System; so, in fact, when selecting ColorSync
it is the built-in color management part of Mac OS that is performing the color management, and
it is done based on the ICC profiles of specified paper type.
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NOTE:

Color management

You are recommended to consult the Knowledge Center at http://www.hp.com/go/knowledge_center/
djz2100/ to see how to use the color management options of your particular application.
To choose between Application-Managed Colors and Printer-Managed Colors:
●

In the Windows driver dialog: select the Color tab.

●

In the Mac OS Print dialog: select the Paper Type/Quality panel, then Color.

●

In some applications: you can make this choice in the application.

Color emulation modes
If you want to print a particular print job and to see approximately the same colors that you would get
from printing the same job on an HP Designjet 500/800 series printer, you can use the emulation mode
provided by your printer.
NOTE: This option is available only when printing an HP-GL/2 job with the HP-GL/2 Upgrade.
●

●

In the Windows HP-GL/2 driver dialog: select the Color tab, then Printer Managed Colors, then
select Printer Emulation from the Source Profile list. You can then select from the Emulated Printer
list.
Using the front panel: select the Setup menu icon
Emulate printer > HP Designjet 500/800 series.

, then Printing preferences > Color >

As well as selecting the emulation mode, you must select the paper type that you intend to use. The
available choices are:
●

None (no emulation)

●

Plain paper (or Bright White Inkjet Paper)

●

Coated Paper

●

Heavyweight Coated Paper

Color adjustment options
The aim of color management is to print accurate colors. If you perform color management correctly,
then you should be able to print accurate colors with no need of any manual color adjustments.
However, manual adjustments may be useful in the following situations:
●

If your color management is not working correctly for some reason

●

If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color
or in grayscale.

Printing in color
You can adjust the colors of your print in similar ways under Windows and Mac OS:
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●

In the Windows driver dialog: select the Color tab, ensure that the Advanced Color
Adjustments box is checked, then press the Settings button beside it.

●

In the Mac OS Print dialog: select the Paper Type/Quality panel, then Lightness and Hue.
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●

The lightness slider simply makes the whole print lighter or darker.

●

The color sliders can be used to fade or emphasize each of the primary colors in the print. The
primary colors may be red, green, and blue; or cyan, magenta, and yellow; depending on the color
model used in the image.

The Reset button restores each slider to its default central position.

Printing in grayscale
You can adjust the gray balance of your print in similar ways under Windows and Mac OS:
●

In the Windows driver dialog: select the Color tab, ensure that the Advanced Color
Adjustments box is checked, then press the Settings button beside it.

●

In the Mac OS Print dialog: select the Paper Type/Quality panel, then Gray balance.

Under either operating system, you will then be able to make adjustments using separate controls for
highlights, midtones, and shadows.

●

The lightness slider simply makes the whole print lighter or darker. This slider is available under
Windows in the same window as the other grayscale controls; it is available under Mac OS by
selecting Lightness and Hue.

●

The zone definition sliders can be used to define what you mean by highlight, midtone, and shadow.

●

The other controls for highlight, midtone, and shadow can be used to adjust the gray balance of
highlights, midtones, and shadows respectively.

The Reset button restores each control to its default setting.
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Under either operating system, you will then be able to make adjustments using a lightness slider and
three color sliders.

Color management

Color management scenarios
The following step-by-step instructions for specific printing jobs using specific software are similar to
those you can find in HP's Knowledge Center on the Web. You are recommended to consult the
Knowledge Center at http://www.hp.com/go/knowledge_center/djz2100/ for further examples and for
the most up-to-date information.

Print a color photo for an exhibition (Photoshop, Mac OS)
This example uses Adobe Photoshop CS2 under Mac OS X and the color management is done by
Photoshop.
1.
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Initial recommendations:
●

Choose an appropriate paper type for the purpose.

●

The paper type should be calibrated and profiled with the printer and the print-quality level
that you intend to use. See Color calibration on page 58 and Color profiling on page 59.

●

For a correct preview of the printed image, the monitor should also be profiled.

2.

Open Adobe Photoshop CS2.

3.

From the Edit menu, select Color Settings.
●

Make sure that More Options are displayed.

●

Color Management Policies: select Preserve Embedded Profiles.

●

Profile Mismatches: check Ask When Opening and Ask When Pasting.

●

Missing Profiles: check Ask When Opening.

●

Conversion Options > Intent: select Perceptual.

●

Click OK.
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5.

From the File menu, select Open to open the image.
●

If the document has an embedded color profile that does not match the current working space,
select Use the embedded profile. Otherwise, select Assign working space; in this case, if
the displayed image does not look correct, try assigning it to other color spaces with Edit >
Assign Profile (try sRGB, Adobe RGB, ColorMatch RGB and others) until you are satisfied.

●

Click OK.

From the File menu, select Print with Preview.
●

ENWW

Select Page Setup.
◦

Format for: select the printer (for example, HP Designjet Z2100 24in Photo).

◦

Paper Size: select the size of the paper that is currently loaded into the printer.

◦

Orientation: select the orientation of your image on the paper.

◦

Click OK.

●

Set the Position and the Scaled Print Size you need.

●

Make sure that More Options are displayed.

●

Select the Color Management tab.
◦

Print: select Document.

◦

Options > Color Handling: select Let Photoshop Determine Colors.

◦

Options > Printer Profile: select the right profile for your printer and paper type.

Color management scenarios
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4.

Color management

◦

●
6.

Click Print.

Choose driver settings.
●

Printer: select the printer (for example, HP Designjet Z2100 24in Photo).

●

Select Paper Type/Quality from the drop-down menu, then select the Paper tab.

●

◦

Paper Type: select the paper type that is currently loaded into the printer.

◦

Quality Options: select Standard and drag the slider to Quality.

Select the Color tab.
◦
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Options > Rendering Intent: select Perceptual.

Select Print in Color.
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●

Color management

◦

Under Color Management, select Application Managed Colors.

Click Print.

Print a black-and-white photo for an exhibition (Photoshop, Mac OS)
This example uses Adobe Photoshop CS2 under Mac OS X and the color management is done by the
printer.
NOTE: Application-managed colors could be used in this example, exactly as in the previous example.
However, printer-managed colors will be used this time, in order to illustrate both methods of color
management.
The recommended approach to creating a black-and-white image is to take a color image and convert
it to grayscale in an image editing program such as Photoshop. In this scenario, however, this conversion
will take place in the printer. If you want to convert a color image to black-and-white in Photoshop CS2,
you have to go through the optional step 5.
1.
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Initial recommendations:
●

Choose an appropriate paper type for the purpose.

●

The paper type should be calibrated and profiled with the printer and the print-quality level
that you intend to use. See Color calibration on page 58 and Color profiling on page 59.

●

For a correct preview of the printed image, the monitor should also be profiled.

2.

Open Adobe Photoshop CS2.

3.

From the Edit menu, select Color Settings.
●

Make sure that More Options are displayed.

●

Color Management Policies > RGB: select Preserve Embedded Profiles.

●

Profile Mismatches: check Ask When Opening and Ask When Pasting.

●

Missing Profiles: check Ask When Opening.
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4.

5.
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●

Conversion Options > Intent: select Perceptual.

●

Click OK.

From the File menu, select Open to open the image.
●

If the document has an embedded color profile that does not match the current working space,
select Use the embedded profile. Otherwise, select Assign working space; in this case, if
the displayed image does not look correct, try assigning it to other color spaces with Edit >
Assign Profile (try sRGB, Adobe RGB, ColorMatch RGB and others) until you are satisfied.

●

Click OK.

(Optional) Use Photoshop to convert the image to grayscale. The simple way is to go to the
Image menu and select Mode > Grayscale.
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6.

a.

Check Monochrome.

b.

Drag any source channel's slider to the left to decrease the channel's contribution to the output
channel or to the right to increase it, or enter a value between -200% and +200% in the text
box (for example: 30% Red, 59% Green, 11% Blue). Using a negative value inverts the source
channel before adding it to the output channel.

c.

Drag the slider or enter a value for the Constant option. This option adds a black or white
channel of varying opacity: negative values act as a black channel, positive values act as a
white channel.

d.

Click OK.

From the File menu, select Print with Preview.
●
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Select Page Setup.
◦

Format for: select the printer (for example, HP Designjet Z2100 24in Photo).

◦

Paper Size: select the size of the paper that is currently loaded into the printer.

◦

Orientation: select the orientation of your image on the paper.

◦

Click OK.

●

Set the Position and the Scaled Print Size you need.

●

Make sure that More Options are displayed.

●

Select the Color Management tab.
◦

Print: select Document.

◦

Options > Color Handling: select Let Printer Determine Colors.
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Alternatively, you can go to the Image menu and select Adjustments > Channel Mixer, to choose
the percentage contribution of each color channel to the grayscale image, as follows:

Color management

◦

●
7.

Options > Rendering Intent: select Perceptual.

Click Print.

Choose driver settings.
●

Printer: select the printer (for example, HP Designjet Z2100 24in Photo).

●

Select Paper Type/Quality from the drop-down menu, then select the Paper tab.

●

◦

Paper Type: select the paper type that is currently loaded into the printer.

◦

Quality Options: select Standard and drag the slider to Quality.

Select the Color tab.
◦

Select Print in Grayscale and Gray and Black Inks only (if you are not printing on
glossy paper, the latter option is grayed out).
TIP: If you experience bronzing with these options, see Bronzing on page 130.
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●

Under Color Management, select Printer Managed Colors, and then select Use Adobe
RGB (1998) from the source profile list.

Click Print.

Print a digital album (Aperture, Mac OS)
This example uses Apple Aperture under Mac OS X and the color management is done by Aperture.
1.

●

Choose an appropriate paper type for the purpose.

●

The paper type should be calibrated and profiled with the printer and the print-quality level
that you intend to use. See Color calibration on page 58 and Color profiling on page 59.

●

For a correct preview of the printed image, the monitor should also be profiled.

2.

Open Apple Aperture.

3.

If you haven't already created a project for this album, go to the File menu and select New
Project, then name the project. Select the new project in the projects menu (on the left), then go
to the File menu and select Import > Folders into a Project.

4.

Select the images you want to use, then go to the File menu and select New From Selection >
Book.

5.

ENWW

Initial recommendations:

●

Theme list: select a theme in the list to see a preview of its design on the right.

●

Book Size popup menu: select the physical size of the book.

●

Click Choose Theme, and rename the book album.

If you like, change the page layout and customize it. You can add photo and text boxes, modify the
box positions and the text styles.

Color management scenarios
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Color management

◦

Color management

6.

7.
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You can let Aperture place your images into the book automatically (select Autoflow Unplaced
Images from the Book Actions menu
), or you can place them manually by drag and drop.
Furthermore:
●

You can scale, crop, and pan the image.

●

You can set an image as page background and apply wash.

Print your book, using the Print button in the Book Layout Editor.
●

Presets Name list: select your book preset.

●

Select Copies and Pages to print.

●

Paper Size: select the paper size on which you want to print the job.

●

Orientation: select the orientation of your image on the paper.

●

ColorSync Profile: select the correct color profile for the printer and paper that you will use.

●

Select Black Point Compensation.
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8.

Gamma: Because computer displays are illuminated, images displayed on computers tend
to look more luminous than when printed. Increasing the Gamma from the default of 1.0 can
compensate for this. Usually, a setting 1.1 to 1.2 is adequate.

Click the Printer Settings button.
●

Printer: select the printer (for example, HP Designjet Z2100 24in Photo).

●

Select Paper Type/Quality from the drop-down menu, then select the Paper tab.

●

◦

Paper Type: select the paper type that is currently loaded into the printer.

◦

Quality Options: select Standard and drag the slider to Quality.

Select the Color tab.
◦

ENWW

Select Print in Color.
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Color management

●

Color management

◦

●

Under Color Management, select Application Managed Colors.

Click Print.

Proof a press using the EFI RIP
1.

Open EFI Designer Edition for HP.

2.

Open the RIP Preferences, and the Color tab will appear by default.

3.

74

●

Select Proofing as Color output preset.

●

Select the input/emulation CMYK profile for the press you want to emulate. For example,
ISOcoated.icc (for Europe), Best_SWOP_Ref_Presssheet_2003.icc (for US). You can find
more information about EFI default profiles in Chapter 4.2.2 “Image profiles” of the RIP
manual.

●

If you do not find your desired press profile in the list, just add it by selecting the Add
Profile button.

●

Press the Advanced button and check the setting Use Embedded Profiles. It will use the
profiles included in the image, if any.

●

Choose the paper and print mode you want to use under Media profiles.

●

Click OK to close the Preferences window.

You can select any other layout- or printer-dependent settings in the Printer and Layout settings.
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Color management

4.

Drag and drop the file you want to proof to the RIP queue (see picture).

Remember the supported formats are: PS level 3, PDF 1.7, EPS, TIFF, JPEG, DCS 2.0, PDF/X1a,
PDF/X.
5.
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Click Print in the toolbar or in the menu, and that’s it!

Color management scenarios
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Retrieving printer usage information

●

Get printer accounting information

●

Check printer usage statistics

●

Check ink and paper usage for a job

Retrieving printer usage
information
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Get printer accounting information
There are various different ways of getting accounting information from your printer.

Retrieving printer usage
information

●

View printer usage statistics for the whole lifetime of the printer, see Check printer usage
statistics on page 78.

●

View ink and paper usage for each of your recent jobs by using HP Easy Printer Care (Windows)
or HP Printer Utility (Mac OS) or the front panel, see Check ink and paper usage for a job
on page 78. If HP Easy Printer Care or HP Printer Utility is not available, see Access HP Easy
Printer Care (Windows) or HP Printer Utility (Mac OS) on page 19.

●

Use a third-party application to request printer status, printer usage, or job accounting data from
the printer through the Internet. The printer provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Check printer usage statistics
There are two ways to check your printer's usage statistics.
NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with HP Easy Printer Care (Windows) or HP Printer Utility
(Mac OS)
1.

Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS), see Access HP Easy
Printer Care (Windows) or HP Printer Utility (Mac OS) on page 19.

2.

Go to the Usage window to view the total printer usage.

3.

Under Windows, go to the Overview tab and click on the Printer usage link.
Under Mac OS, select Information > Printer Usage and click on the Start button.

Printer statistics with the Embedded Web Server
1.

Access the Embedded Web Server, see Access the Embedded Web Server on page 19.

2.

Go to the Main tab.

3.

Select History > Usage.

Check ink and paper usage for a job
There are two ways to check ink and paper usage for a job.
NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS)
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1.

Access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS), see Access HP Easy
Printer Care (Windows) or HP Printer Utility (Mac OS) on page 19.

2.

Go to the Accounting window to view information regarding the most recent jobs.

3.

Under Windows, go to the Job Accounting tab.
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Under Mac OS, select Information > Job Accounting and click on the Look Up button.

Printer statistics with the Embedded Web Server
Access the Embedded Web Server, see Access the Embedded Web Server on page 19.

2.

Go to the Main tab.

3.

Select History > Accounting.

Retrieving printer usage
information

1.
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Check ink and paper usage for a job

79

Retrieving printer usage
information
80

Chapter 7 Retrieving printer usage information

ENWW

ENWW

Handling ink cartridges and printheads

●

About the ink cartridges

●

Check the ink cartridges status

●

Remove an ink cartridge

●

Insert an ink cartridge

●

About the printheads

●

Check the printhead status

●

Remove a printhead

●

Insert a printhead

Handling ink cartridges
and printheads
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About the ink cartridges
Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper.
You can purchase 130 ml ink cartridges for your printer, see Accessories on page 103.
CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive
devices (see the Glossary on page 165). Avoid touching pins, leads, and circuitry.

Check the ink cartridges status
To view the ink levels of your ink cartridges, press the View ink level key on the front panel.
To get more information on your ink cartridges, you can use the front panel ink menu, HP Easy Printer
Care (Windows), or HP Printer Utility (Mac OS).
For an explanation of the ink cartridge status messages, see Ink cartridge status messages
on page 138.

Ink menu procedure
1.

Handling ink cartridges
and printheads

Press the Menu key to return to the main menu and select the Ink menu icon
cartridge information.
2.

Select the cartridge on which you want information.

3.

The front panel displays:
●

Color

●

Product name

●

Product number

●

Serial number

●

Status

●

Ink level, if known

●

Total ink capacity in milliliters

●

Expiration date

●

Manufacturer

●

Warranty status

, then Ink

HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS) procedures
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●

In HP Easy Printer Care (Windows), go to the Overview tab, each cartridge's status is under
Supply Status > Cartridges.

●

In HP Printer Utility (Mac OS), select Information > Printer Status.
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Remove an ink cartridge
There are three occasions when you need to remove an ink cartridge.
●

The ink level in the cartridge is very low and you want to replace it with a full cartridge for unattended
printing (you can use up the remaining ink in the first cartridge at a more convenient time).

●

The ink cartridge is empty or faulty, and you must replace it to continue printing.

●

The ink cartridge has expired.

CAUTION: Do not try to remove an ink cartridge while printing.
CAUTION: Remove an ink cartridge only if you are ready to insert another one.
WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

ENWW

Press the Menu key to return to the main menu and select the Ink menu icon
ink cartridges.

, then Replace

2.

Open the ink cartridge cover completely. Magenta and yellow are in the left side, while light
magenta, light cyan, photo black, light gray, matte black, and cyan are in the right side.

3.

Grip the cartridge you wish to remove.

Remove an ink cartridge

Handling ink cartridges
and printheads

1.
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4.

Pull the cartridge straight up.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be
ink on the connection.
NOTE:

Handling ink cartridges
and printheads

5.

Avoid storing partially used ink cartridges.

The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge
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1.

Before removing the cartridge from its wrapping, shake it vigorously.

2.

Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters
(in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the
cartridge label.

3.

Insert the ink cartridge into its slot.
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4.

Push the cartridge into the slot until it snaps into position. You should hear a beep and see
confirmation that the cartridge has been inserted.

5.

When all cartridges have been inserted, close the cover.

6.

The front-panel display confirms that all cartridges have been correctly inserted, press the OK key
on the front panel.

About the printheads
The printhead are connected to the ink cartridges and jet ink onto the paper.
CAUTION: Observe precautions when handling printheads because they are ESD-sensitive devices
(see the Glossary on page 165). Avoid touching pins, leads, and circuitry.

Check the printhead status
The printer automatically checks and services the printheads after each print. Follow the steps below
to get more information on your printheads.
1.

ENWW

Press the Menu key to return to the main menu and select the Ink menu icon
information.

2.

Select the printhead on which you want information.

3.

The front panel displays:
●

Colors

●

Product name

●

Product number

●

Serial number

, then Printhead

About the printheads
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If you have difficulty, see Cannot insert an ink cartridge on page 138.

●

Status, see Front-panel error messages on page 151

●

Volume of ink it has used

●

Warranty status

You can also get most of this information without leaving your computer by using HP Easy Printer Care
(Windows) or HP Printer Utility (Mac OS).
For an explanation of the printhead status messages, see Printhead status messages on page 144.
If the warranty status is See warranty note, this indicates that non-HP ink is being used. See the HP
Legal Information document provided with your printer for details of the warranty implications.

Remove a printhead
WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

Handling ink cartridges
and printheads

WARNING! Printhead replacement must be performed with the printer powered on.
1.
Press the Menu key to return to the main menu and select the Ink menu icon
printheads.

2.

, then Replace

The printer moves the carriage into the correct position.
CAUTION: If the carriage is left in the removal position for more than three minutes without
inserting or removing any printheads, it tries to move back to its normal position in the right-hand
end.

3.
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When the carriage has stopped moving, the front-panel display asks you to open the window.
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Locate the carriage on the right side of the printer.

5.

To Pull the handle up and toward you to release the wire loop.

6.

Push the handle back to raise the lid.

7.

This gives you access to the printheads.

8.

To remove a printhead, lift up the blue handle.

Handling ink cartridges
and printheads

4.

Remove a printhead
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9.

Using the blue handle, use steady force to disengage the printhead.

10. Pull the blue handle upward until the printhead is released from the carriage.
CAUTION:

Do not pull abruptly because this can damage the printhead.

Handling ink cartridges
and printheads

11. The front-panel display identifies the missing printhead.

Insert a printhead
1.
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If the printhead is new, shake the printhead vigorously before removing the protective caps.
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Remove the orange protective caps by pulling them down.

3.

Clean the bottom of the printhead by wiping it with the swab provided or with a cotton swab and
de-ionized or distilled water.

WARNING! Do not touch the electrical connections on the backside of the printhead.
4.

ENWW

The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check
that the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.

Insert a printhead
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2.

5.

Insert the new printhead into its correct slot in the carriage.
CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you
insert it too fast, or at an angle, or if you rotate it as you insert it.

6.

Push down as indicated by the arrow shown below.

Handling ink cartridges
and printheads

CAUTION: When installing the new printhead there may be some resistance, so you need to
press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel
display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead
on page 138.
7.
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Insert any other printheads, that need to be installed, with the same procedure, then close the
carriage lid.
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Ensure the end of the blue handle catches the wire loop on the near side of the carriage.

9.

Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer
beeps.
NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front-panel display, the printhead may need to be reinserted.
10. Close the window.

11. The front-panel display confirms that all printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are
changed, takes 25 minutes. If the printer finds problems in preparing the printheads, it takes longer,
up to 55 minutes. For a single printhead insertion, the times vary between 20 and 40 minutes. After
all printheads are checked and prepared, the printhead realignment procedure runs automatically
if paper is loaded, see Align the printheads on page 142.
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Insert a printhead
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8.
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●
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●

Update the firmware

●

Update the software

●

Printer maintenance kits
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Check printer status
You can check the current status of the printer in various ways:
●

If you start HP Easy Printer Care under Windows or HP Printer Utility under Mac OS, and select
your printer, you see a page of information describing the status of the printer and its paper and
ink supplies.

●

If you access the Embedded Web Server, you see information about the general status of the
printer. The Supplies page in the Main tab describes the status of the paper and ink supplies.

●

The status screen of the printer's front panel notifies you of any current problems affecting the
printer as a whole. You can also request information about:
◦

The currently loaded paper, with the View loaded paper key

◦

The ink levels, with the View ink levels key

◦
◦

The ink cartridges, by selecting the Ink menu icon
The printheads, by selecting the Ink menu icon

and then Ink cartridge information
and then Printhead information

Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid
soap.
WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before
you clean it. Do not let water get inside the printer.
CAUTION: Do not use abrasive cleaners on the printer.

Maintaining the printer

Replace the cutter
The cutter may need to be replaced once or twice during the life of the printer, depending on the total
amount and thickness of paper used. The front panel advises when replacement is due. If you do not
replace the cutter immediately, the printer continues working normally, but the front panel continues to
remind you about the cutter.
To replace the cutter:
1.

If there is paper loaded in the printer, unload it.

2.
At the front panel, select the Setup menu icon
counters.
3.

, then Advanced > Resets > Reset cutter life

After a brief pause, the printer turns itself off. The printhead carriage is parked on the right-hand
side of the printer, and the cutter on the left-hand side.
WARNING! There is a risk of electric shock if you attempt to replace the cutter with the printer
turned on.
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Lift the ink cartridge cover on the left-hand side of the printer.

5.

Press the button behind the ink cartridges to release the cover of the left-hand end of the printer.

6.

Remove the left end cover.

Maintaining the printer

4.
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Replace the cutter
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7.

Unscrew and remove the cutter stop using the TORX PLUS screwdriver provided with the new
cutter. The screw is captive and will not fall out.

8.

Remove the old cutter.

9.

Take the new cutter from the maintenance kit and move the plunger at the top slowly back and
forth within its housing to check that it moves freely.
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10. Slide the new cutter into position on the cutter rail.

The two wheels on the bottom of the cutter should engage the central ridge on the cutter rail, and
the two bushing guides should fit into the groove in the upper part of the cutter rail.

Maintaining the printer

Check that the cutter runs smoothly up and down the rail. You can leave it anywhere on the rail;
the printer will park it correctly later.
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11. Fit the cutter stop onto the end of the cutter rail, holding it there with one hand while you tighten
the screw with the screwdriver in your other hand.

12. Put the left end cover back on the printer, aligning the protrusions with the holes in the printer.

Maintaining the printer

13. Close the ink cartridge cover.

14. At the front panel, turn the printer back on. The printer checks that the cutter has been correctly
installed. Look at the front panel and follow its instructions if there is any problem.
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Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's front
panel notifies you when any cartridge reaches its expiration date.
You can also check a cartridge's expiration date at any time: see Check printer status on page 94.
See also Handling ink cartridges and printheads on page 81.

Move or store the printer
If you need to move or store the printer, prepare it correctly to avoid possible damage to it. To prepare
the printer, follow the instructions below.
1.

Do not remove the ink cartridges or printheads.

2.

Make sure that no paper is loaded.

3.

Make sure that the printer is idle.

4.

Disconnect any cables connecting the printer to a network or a computer.

1.

Turn off the power using the Power key on the front panel.

2.

Also turn off the power switch at the rear of the printer.

3.

Disconnect the printer's power cable.

4.

Before transporting the printer, secure the rear tray in the closed position with tape. Otherwise, the
tray could open and perhaps break and fall out of the printer.

CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious
damage.
When the printer is turned back on, it takes about three minutes to initialize itself and to check and
prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the
printer has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.
CAUTION: If the printer remains off for a long period of time, the printheads may become unusable.
In this case, you need to replace the printheads with new ones.
After a storage period, if maintaining color accuracy is important to you, you are recommended to purge
some ink from the printheads before starting the color calibration process. This is in addition to any ink
already used in preparing the printheads. Go to the front panel and select the Image Quality Maintenance
menu icon

ENWW

, then Advanced > Purge ink.
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If you need to leave the printer turned off for a long time, follow the additional steps below.

TIP: Because preparing and purging the printheads uses both time and ink, you are strongly
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health
of the printheads. In both cases, the printer wakes up from time to time to maintain the printheads. Thus
you can avoid going through lengthy preparation processes before using your printer.

Update the firmware
The printer's various functions are controlled by software that resides in the printer, otherwise known
as firmware.
From time to time firmware updates will be available from Hewlett-Packard. These updates increase the
printer's functionality and enhance its features.
Firmware updates can be downloaded from the Internet and installed in your printer in the following
ways; you can choose whichever you find most convenient.
●

Using HP Easy Printer Care under Windows, select your printer, the Support tab, and then
Firmware Update.

●

Using HP Printer Utility under Mac OS, select Support and then Firmware Update.

●

Using your printer's Embedded Web Server, select the Setup tab and then Firmware update.

In each case, follow the instructions on your screen to download the firmware file and store it on your
hard disk. Then select the downloaded file and click Update.
If you experience very slow progress while uploading the firmware file to the printer, the reason could
be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the
Embedded Web Server directly.

Maintaining the printer

●

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

●

In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

The firmware includes a set of the most commonly used paper profiles. Extra paper profiles can be
downloaded separately; see Paper profiles on page 36.

Update the software
To update the printer driver and other software for any HP Designjet printer, go to http://www.hp.com/
go/designjet/ and select Downloads, then Drivers. Then select your printer, your preferred language,
and your operating system.
If your operating system is Windows, HP Software Update regularly offers to update your software
automatically. Alternatively, HP Easy Printer Care provides a Software Update link in its Support tab.

Printer maintenance kits
Three maintenance kits are available for your printer, containing components that may need to be
replaced after long use. When one of them is needed, a message is displayed on the front panel and
by HP Easy Printer Care under Windows or HP Printer Utility under Mac OS.
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When you see the message, you should contact HP Support (see Contact HP Support on page 158)
and request the maintenance kit. Two of the kits are installed by service engineers only; the third consists
of a replacement cutter, which you can install yourself (see Replace the cutter on page 94).
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How to order supplies and accessories
There are two alternative ways to order supplies or accessories for your printer:
●

Visit http://www.hp.com/go/designjetz2100_order/ on the Web.

●

Contact HP Support (see Contact HP Support on page 158).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies
The following ink supplies can be ordered for your printer.
Table 10-1 Ink cartridges
Cartridge

Part number

HP 70 Matte Black 130 ml Ink Cartridge

C9448A

HP 70 Photo Black 130 ml Ink Cartridge

C9449A

HP 70 Light Gray 130 ml Ink Cartridge

C9451A

HP 70 Cyan 130 ml Ink Cartridge

C9452A

HP 70 Magenta 130 ml Ink Cartridge

C9453A

HP 70 Yellow 130 ml Ink Cartridge

C9454A

HP 70 Light Magenta 130 ml Ink Cartridge

C9455A

HP 70 Light Cyan 130 ml Ink Cartridge

C9390A

HP 70 Matte Black 130 ml Ink Cartridge Twin Pack

CB339A

HP 70 Photo Black 130 ml Ink Cartridge Twin Pack

CB340A

HP 70 Light Gray 130 ml Ink Cartridge Twin Pack

CB342A

HP 70 Cyan 130 ml Ink Cartridge Twin Pack

CB343A

HP 70 Magenta 130 ml Ink Cartridge Twin Pack

CB344A

HP 70 Yellow 130 ml Ink Cartridge Twin Pack

CB345A

HP 70 Light Magenta 130 ml Ink Cartridge Twin Pack

CB346A

HP 70 Light Cyan 130 ml Ink Cartridge Twin Pack

CB351A

Table 10-2 Printheads

Accessories

Printhead

Part number

HP 70 Matte Black & Cyan Printhead

C9404A

HP 70 Light Magenta & Light Cyan Printhead

C9405A

HP 70 Magenta & Yellow Printhead

C9406A

HP 70 Photo Black & Light Gray Printhead

C9407A

Order paper
The following paper types are currently provided for use with your printer.
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NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/designjet/supplies/.
Key to availability:
●

(A) indicates papers available in Asia (excluding Japan)

●

(E) indicates papers available in Europe, the Middle East, and Africa

●

(J) indicates papers available in Japan

●

(L) indicates papers available in Latin America

●

(N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.
Table 10-3 Roll paper
Paper type

g/m²

Length

Width

Part numbers

HP Professional Satin Photo Paper

300

50 ft = 15.2 m

24 in = 610 mm

Q8759A

HP Premium Instant-Dry Satin
Photo Paper

260

50 ft = 15.2 m

18 in = 458 mm

Q8001A

75 ft = 22.8 m

24 in = 610 mm

Q7992A

100 ft = 30.5 m

36 in = 914 mm

Q7994A (AEJN)

42 in = 1067 mm

Q7996A (AEJN)

50 ft = 15.2 m

18 in = 458 mm

Q7990A

75 ft = 22.8 m

24 in = 610 mm

Q7991A

100 ft = 30.5 m

36 in = 914 mm

Q7993A

HP Photographic Paper

HP Premium Instant-Dry Gloss
Photo Paper

260

(AEJN)

HP Universal Instant-Dry Photo
Gloss

HP Universal Instant-Dry Photo
Semi-Gloss

HP Photo Paper RC Matte

190

190

100 ft = 30.5 m

100 ft = 30.5 m

42 in = 1067 mm

Q7995A (AEJN)

24 in = 610 mm

Q6574A

36 in = 914 mm

Q6575A

42 in = 1067 mm

Q6576A

24 in = 610 mm

Q6579A

36 in = 914 mm

Q6580A

42 in = 1067 mm

Q6581A

200

100 ft = 30.5 m

36 in = 914 mm

C7946A (AEN)

400

20 ft = 6.1 m

24 in = 610 mm

Q8708A

50 ft = 15.2 m

36 in = 914 mm

Q8709A

42 in = 1067 mm

Q8710A

20 ft = 6.1 m

24 in = 610 mm

Q8673A (ELN)

50 ft = 15.2 m

36 in = 914 mm

Q8761A (ELN)

42 in = 1067 mm

Q8674A (ELN)

HP Collector Satin Canvas

HP Professional Matte Canvas
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HP Fine Art Printing Material

Table 10-3 Roll paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Artist Matte Canvas

380

20 ft = 6.1 m

24 in = 610 mm

Q8704A

50 ft = 15.2 m

36 in = 914 mm

Q8705A

42 in = 1067 mm

Q8706A

20 ft = 6.1 m

24 in = 610 mm

Q8712A

50 ft = 15.2 m

36 in = 914 mm

Q8713A

42 in = 1067 mm

Q8714A

24 in = 610 mm

Q8732A (EN)

36 in = 914 mm

Q8745A (EN)

42 in = 1067 mm

Q8733A (EN)

24 in = 610 mm

Q8734A (EN)

42 in = 1067 mm

Q8735A (EN)

24 in = 610 mm

Q8736A (EN)

36 in = 914 mm

Q8737A (EN)

42 in = 1067 mm

Q8738A (EN)

24 in = 610 mm

Q8739A (EN)

42 in = 1067 mm

Q8740A (EN)

HP Universal Matte Canvas

HP Hahnemühle Smooth Fine Art
Paper

350

265

310

HP Hahnemühle Textured Fine Art
Paper

265

310

35 ft = 10.7 m

35 ft = 10.7 m

35 ft = 10.7 m

35 ft = 10.7 m

HP Hahnemühle Watercolor Paper

210

38 ft = 11.6 m

36 in = 914 mm

Q1984A (EN)

HP Aquarella Art Paper

240

35 ft = 10.7 m

24 in = 610 mm

Q8741A (EN)

36 in = 914 mm

Q8746A (EN)

HP Canvas Paper 180 gram

180

35 ft = 10.7 m

36 in = 914 mm

Q1724A (EN)

HP Matte Litho-Realistic Paper

270

100 ft = 30.5 m

24 in = 610 mm

Q7972A (EN)

36 in = 914 mm

Q7973A (EN)

18 in = 458 mm

Q8664A (EN)

24 in = 610 mm

Q8663A (EN)

18 in = 458 mm

Q8049A (EN)

24 in = 610 mm

Q7971A (EN)

18 in = 458 mm

Q7896A (EN)

24 in = 610 mm

Q1968A (EN)

HP Proofing Paper
HP Professional High-Gloss
Contract Proofing Paper

200

HP Professional Semi-Gloss
Contract Proofing Paper

235

HP Proofing Matte

146

100 ft = 30.5 m

100 ft = 30.5 m

100 ft = 30.5 m

HP Banner and Sign Material

Accessories

HP Durable Display Film

205

50 ft = 15.2 m

36 in = 914 mm

Q6620A (EN)

HP Instant-Dry Indoor Banner,
Gloss

195

50 ft = 15.2 m

36 in = 914 mm

Q5482A (N)

42 in = 1067 mm

Q5483A (AJN)

HP Opaque Scrim

486

36 in = 914 mm

Q1898B (AEN)

42 in = 1067 mm

Q1899B (AEN)

50 ft = 15.2 m

HP Banners with Tyvek

140

50 ft = 15.2 m

36 in = 914 mm

C6787A (AEN)

HP Outdoor Paper

145

100 ft = 30.5 m

36 in = 914 mm

Q1730A (EN)
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Table 10-3 Roll paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Outdoor Billboard Paper Blue
Back

140

100 ft = 30.5 m

36 in = 914 mm

C7949A (EN)

205

100 ft = 30.5 m

36 in = 914 mm

C6778A (AEJN)

HP Backlit Material
HP Colorlucent Backlit UV

HP Self-Adhesive Material and Laminate
HP Polypropylene, Matte —
Adhesive Backed

225

70 ft = 21.3 m

36 in = 914 mm

Q1908A (AEN)

HP Colorfast Adhesive Vinyl

328

40 ft = 12.2 m

36 in = 914 mm

C6775A

HP Universal Adhesive Vinyl

290

66 ft = 20.1 m

36 in = 914 mm

Q8676A (EN)

42 in = 1067 mm

Q8677A (EN)

23.39 in = 594 mm

Q8003A (J)

24 in = 610 mm

Q1396A

36 in = 914 mm

Q1397A

42 in = 1067 mm

Q1398A

23.39 in = 594 mm

Q8004A (EJ)

33.11 in = 841 mm

Q8005A (EJ)

16.54 in = 420 mm

Q1446A (J)

23.39 in = 594 mm

Q1445A (EJ)

24 in = 610 mm

C1860A (LN),
C6035A (AEJ)

33.11 in = 841 mm

Q1444A (EJ)

36 in = 914 mm

C1861A (LN),
C6036A (AEJ)

300 ft = 91.4 m

36 in = 914 mm

C6810A

150 ft = 45.7 m

24 in = 610 mm

Q1404A (AEJN)

36 in = 914 mm

Q1405A (AEJN)

42 in = 1067 mm

Q1406A

16.54 in = 420 mm

Q1443A (J)

18 in = 458 mm

Q7897A (EN)

23.39 in = 594 mm

Q1442A (EJ)

24 in = 610 mm

C6019B

33.11 in = 841 mm

Q1441A (EJ)

36 in = 914 mm

C6020B

42 in = 1067 mm

C6567B

300 ft = 91.4 m

36 in = 914 mm

C6980A

100 ft = 30.5 m

24 in = 610 mm

Q1412A (AEJN)

36 in = 914 mm

Q1413A

42 in = 1067 mm

Q1414A (AEJN)

HP Universal Inkjet Bond Paper

80

150 ft = 45.7 m

300 ft = 91.4 m

HP Bright White Inkjet Bond Paper

HP Universal Coated Paper

HP Coated Paper

HP Universal Heavyweight Coated
Paper

ENWW

90

95

90

120

150 ft = 45.7 m

150 ft = 45.7 m

How to order supplies and accessories 107

Accessories

HP Bond and Coated Paper

Table 10-3 Roll paper (continued)
Paper type

g/m²

Length

Width

Part numbers

HP Heavyweight Coated Paper

131

100 ft = 30.5 m

24 in = 610 mm

C6029C (AEJN)

36 in = 914 mm

C6030C

42 in = 1067 mm

C6569C

225 ft = 67.5 m

42 in = 1067 mm

Q1956A (EN)

100 ft = 30.5 m

24 in = 610 mm

Q6626A (AEJN)

36 in = 914 mm

Q6627A (AEJN)

42 in = 1067 mm

Q6628A (AEJN)

HP Super Heavyweight Plus Matte
Paper

210

Table 10-4 Sheet paper
Paper type

g/m²

Length

Width

Part numbers

196

19 in = 483 mm

13 in = 330 mm

Q5492A

HP Artist Matte Canvas

360

19 in = 483 mm

13 in = 330 mm

Q8731A (EN)

HP Hahnemühle Smooth Fine Art
Paper

265

19 in = 483 mm

13 in = 330 mm

Q8728A (EN)

HP Hahnemühle Watercolor Paper

210

19 in = 483 mm

13 in = 330 mm

Q8729A (EN)

HP Aquarella Art Paper

240

19 in = 483 mm

13 in = 330 mm

Q8730A (EN)

HP Professional High-Gloss
Contract Proofing Paper

200

19 in = 483 mm

13 in = 330 mm

Q8662A (EN)

HP Professional Semi-Gloss
Contract Proofing Paper

235

19 in = 483 mm

13 in = 330 mm

Q7970A (EJN)

HP Proofing Matte

146

19 in = 483 mm

13 in = 330 mm

Q1967A (AEN)

90

24 in = 610 mm

18 in = 457 mm

Q1961A (AEN)

36 in = 914 mm

24 in = 610 mm

Q1962A (AEN)

11 in = 279 mm

8.5 in = 216 mm

51634Y (N)

17 in = 432 mm

11 in = 279 mm

C1855A (N)

HP Photographic Paper
HP Photo Matte
HP Fine Art Printing Material

HP Proofing Paper

HP Bond and Coated Paper
HP Coated Paper

HP Premium Inkjet Paper

If you are printing on satin photo paper
Accessories

Consider using HP Professional Satin Photo Paper, which can offer:
●

A wider color gamut

●

Better black optical density

●

Better PANTONE coverage

●

A smoother surface

●

Greater robustness
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Non-recommended paper types
In many cases, paper types that HP does not support may nevertheless be compatible with your printer.
However, the following paper types are unlikely to give satisfactory results:
●

Photo paper that swells

●

Brochure paper

Order accessories
The following accessories can be ordered for your printer.
Name

Product number

HP Designjet Z2100 24in Stand (Asia only)

Q6663A

HP-GL/2 Upgrade

Q6692A

EFI Designjet Edition 5.1 for HP XL International

Q6643D

EFI Designjet Edition 5.1 for HP XL Japan

Q6644D

HP Advanced Profiling Solution

Q6695A

HP Jetdirect 635n IPv6/IPsec Print Server

J7961G

Introduction to the accessories
Stand
The printer stand is used to support the printer and the basket, which collects prints as they emerge
from the printer. The main alternative to the stand is to put the printer on a desk.
The stand is normally provided with the HP Designjet Z2100. However, the HP Designjet Z2100 24in is
sold in Asian countries without the stand, and so the stand for this printer is also available separately
as an accessory.
The height of the stand is 668 mm.
The weight of the stand is 12.22 kg (44 inch) or 10.12 kg (24 inch).

HP-GL/2 upgrade
HP-GL/2 is a standard file format that HP developed for CAD applications. It was designed to preserve
line and text quality and minimize network traffic.

●

Compatibility with existing HP-GL/2 files. Some applications (such as CAD applications) produce
HP-GL/2 files, or you may have produced HP-GL/2 files for printing on other HP printers.

●

Reliability when printing over a busy network. HP-GL/2 files are relatively small and pass quickly
and easily over the network.

●

Job queuing means that all HP-GL/2 jobs sent to the printer are added to a queue that you can
view and manage. For instance, you can change the order of the jobs, change the number of copies
to be printed, cancel jobs in the queue, and reprint jobs that have already been printed.

In order to install the HP-GL/2 Upgrade, follow the instructions that come with the kit.
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The HP-GL/2 Upgrade Kit for the HP Designjet Z2100 Photo series enables your printer to understand
and print HP-GL/2 files; and it provides print job management facilities. It has the following advantages.

To check whether your printer already has the HP-GL/2 Upgrade, go to the printer's front panel and
press the Menu key once or twice until you see the main menu icons. If there are eight icons, you have
the HP-GL/2 Upgrade; if there are seven, you do not have it. The HP-GL/2 Upgrade adds the Job Queue
menu icon

.

EFI Designer Edition RIP
The EFI Designer Edition for HP RIP, tailored for HP printers, offers a powerful, cost-effective digital
proofing system that allows full control over digital proofing needs and saves time and money. Together,
EFI and HP enable designers, photographers, and other creative professionals to easily generate proofquality prints with sharp detail, color accuracy, and smooth tonal transitions.
EFI Designer Edition comprises an intuitive, easy-to-use interface and an Adobe PostScript 3 engine
(Adobe CPSI). It offers PDF/X support, a nesting function, and selectable RIP resolutions. The Adobe
CPSI Interpreter supports in-RIP separation, overprinting, and 2-byte font compatibility through a fontdownload facility.
●

Advanced proofing capabilities. EFI Designer Edition produces accurate color proofs at the creation
stage, allowing designers to find and fix costly errors early, save time, and accurately simulate final
press output.

●

Seamless integration with other applications. With Adobe Configurable PostScript 3, EFI Designer
Edition integrates effortlessly with other illustration, photo, and layout applications.

●

Accurate color. The solution includes several key features for advanced color management in RGB,
grayscale, or CMYK workflows. Its Ugra/FOGRA Media Wedge 2.0 allows users to achieve correct
color, while Spot Color Editor supports an unlimited number of spot colors and libraries for
PANTONE, HKS, and Toyo.

●

Extended profile options. The flexible EFI Designer Edition includes reference profiles for selected
printing methods, such as offset or newspaper, and paper profiles for EFI and printer
manufacturers' paper types. If users prefer to use their own profiles, Profile Connector enables
them to integrate them into the workflow.

HP Advanced Profiling Solution
HP and GretagMacbeth have worked together to develop the HP Advanced Profiling Solution, powered
by GretagMacbeth™ technology, which takes advantage of the spectrophotometer built into the printer
to provide a revolutionary end-to-end calibrated ICC color workflow.
The HP Advanced Profiling Solution, tailored for HP printers, offers a powerful and automated, yet costeffective color management system with a fully streamlined workflow that allows you to avoid the cost,
hassle, and delay of offline measurement devices. Together, GretagMacbeth and HP provide a new
experience to designers, photographers, and other creative professionals, whereby they can generate
proofs and photo quality prints accurately and consistently.
The Advanced Profiling Solution includes:

Accessories

●

The HP Colorimeter monitor calibrator, with which you can accurately calibrate and profile all of
your monitors: LCD, CRT, and laptop

●

An ICC profiling and editing software application providing additional features and functionality
beyond those included in the HP Color Center

Using the Advanced Profiling Solution, you can:
●

See matching colors on your screen and printed paper

●

Generate color profiles for all your paper types, in RGB and (if you are using RIP software) CMYK
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●

Edit your color profiles visually for maximum control

●

Perform all operations easily using a step-by-step software interface—no extra manuals needed

The HP Advanced Profiling Solution is fully supported by HP, so you do not need to deal with various
support organizations from different companies.

Key features
The HP Advanced Profiling Solution lets you take control of your colors:
●

Calibrate and profile all of your monitors—LCD, CRT, and laptop

●

Automated RGB profiling via HP software drivers to ensure accurate printing (photos, designs, etc.)

●

Automated CMYK profiling when your printer is driven by a Raster Image Processor (RIP) for
accurate digital prints and proofs

●

Easily and visually edit your profiles for ultimate color control

HP Photosmart Pro print plug-in for Adobe Photoshop
The HP Photosmart Pro print plug-in (ProPrint) is a software module that works directly with Adobe
Photoshop. It is used in place of Photoshop's Print with Preview dialog. ProPrint's functionality makes
it unnecessary to invoke Photoshop's Print with Preview dialog in most cases. Invoked from Photoshop,
ProPrint displays print options similar to those in Photoshop with some significant differences, including
the following:
●

Synchronized control of printer selection and printer driver settings from the top level of the user
interface.

●

Easy control of color management, including synchronization with the printer driver.

●

Orientation control at the top level of the user interface.

●

Friendlier control of image size and placement, including user-definable defaults.

●

Exclusion of most settings that are focused on Graphics Design users (for instance, registration
marks), making the user interface less cluttered.

Accessories

This accessory will be available only from the Designjet Online Web site (http://www.hp.com/go/
designjet/).
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●

The paper cannot be loaded successfully

●

The paper has jammed

●

Prints do not fall nicely into the basket

●

The sheet stays in the printer when the print has been completed

●

The paper is cut when the print has been completed

●

The cutter does not cut well

●

The roll is loose on the spindle

●

A strip stays on the output tray and generates jams

●

Recalibrate the paper advance
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The paper cannot be loaded successfully
●

Ensure no paper is loaded.

●

Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.

●

Do not attempt to straighten the paper during the aligning process, unless instructed to do so by
the front-panel display. The printer automatically attempts to straighten the paper.

●

The paper may be crumpled, or warped, or may have irregular edges.

Unsuccessful roll load
●

If the paper does not load, the leading edge of the paper may not be straight or clean and needs
to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

●

Ensure the roll ends are tight against the spindle ends.

●

Check that the spindle is correctly inserted.

●

Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.

●

Check that all roll stoppers have been removed.

●

Check that the paper is wound tightly on the roll.

●

Do not touch the roll or paper at during the alignment process.

If the paper has not been inserted straight, the front panel displays the following instructions.
1.

When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to
straighten the roll.

2.

When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the roll is aligned, the printer measures the width and you are now ready to print.
If the roll is still not aligned, the front panel displays an error and instructions.

3.

When prompted by the front-panel display, lift the blue lever on the left.

4.

Rewind the roll from the end of the spindle until the edge is on the blue line.

5.

Press OK, on the front panel.

6.

When prompted by the front-panel display, lower the lever. The printer checks the alignment. If the
roll is aligned, the printer measures the width and you are now ready to print.
If the roll is still not aligned, the front panel displays an error and instructions to start again at step
three.
If you would like to start the load process again, cancel the process on the front panel and rewind
the roll from the end of the spindle until the edge is removed from the printer.

Unsuccessful sheet load
●

Guide the sheet, especially thick papers, when the printer initially feeds the sheet.

●

Do not attempt to straighten the sheet during the loading process, unless instructed to by the frontpanel display. The printer automatically attempts to straighten the sheet.

●

Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.
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If the sheet is caught by the printer but is not inserted straight, the front panel displays the following
instructions.
1.

When prompted by the front-panel display, lift the blue lever on the left.

2.

Adjust the sheet to align with the front and right side blue lines.

3.

Once the sheet is aligned, press OK on the front panel.

4.

When prompted by the front-panel display, lower the blue lever. The printer checks the alignment.
If the sheet is aligned, the printer measures the sheet and feed it out the back into the roll feed.
You are now ready to print.
If the sheet is still not aligned, the front panel displays an error and instructions to start again.
If you would like to start the load process again, cancel the process on the front panel and the
printer ejects the sheet out the front.

Paper loading error messages
Here is a list of front-panel display messages related to paper loading, with the suggested corrective
action.

ENWW

front-panel display message

Suggested action

Paper incorrectly loaded.

The paper has not been loaded correctly; the edge was not aligned with the load
guide. Lift the blue lever, remove paper, and lower lever.

Paper not found.

During the paper load process the printer did not detect any paper. Ensure the paper
is inserted fully and is not transparent.

Paper loaded with too much skew.

During the paper load process the printer detected that the paper had too much
skew. Follow the instructions on the front-panel display.

Paper too small.

During the load process the printer detected that the paper is too narrow or too short
to be loaded in the printer. Press the Cancel key to stop the load process. See
Functional specifications on page 162.

Paper too big

During the load process the printer has detected that the paper is either too wide or
too long (sheet only) to be loaded correctly. Press the Cancel key to stop the load
process. See Functional specifications on page 162.

Lever lifted.

During the load process the blue lever was lifted. This prevents the printer from
loading the paper. Follow the instructions on the front-panel display.
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If the sheet is not caught by the printer, the front-panel display asks to push paper further into the printer,
and tries to feed the paper again.

Troubleshooting paper
issues

The paper has jammed
When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.
1.

Power off the printer at the front panel and also switch it off at the rear.

2.

Open the window.

3.

Try to move the printhead carriage out of the way.

4.

Lift the blue lever as far up as it will go.
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Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6.

Standing behind the printer, rewind the roll or pull the cut sheet from the printer. If you cannot see
the paper, return to the front of the printer and remove it from the output tray.
WARNING! Do not move the paper sideways, as it could damage the printer.
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7.

Carefully remove all small pieces of paper.

8.

Lower the blue lever.
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5.
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9.

Close transparent window.

10. Switch on the printer.

11. Reload the roll, or load a new sheet. See Load a roll into the printer or Load a single sheet in Using
your printer.
NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the
procedure and carefully remove all pieces of paper.

Prints do not fall nicely into the basket
●

Ensure the basket is correctly installed.

●

Ensure the basket is open.

●

Ensure the basket not full.

●

Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll,
or remove prints manually as they are completed.

The sheet stays in the printer when the print has been
completed
The printer holds the paper to allow the print to dry after printing, see Change the drying time
on page 38. If the paper is only partially ejected after the drying time, gently pull the sheet out of the
printer. If the automatic cutter is disabled, use the Form feed and cut key on the front panel, see Feed
and cut the paper on page 39.

The paper is cut when the print has been completed
By default the printer cuts the paper after the drying time has been completed, see Change the drying
time on page 38. You can disable the cutter, see Turn the automatic cutter on and off on page 38.
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By default the printer is set to automatically cut the paper after the drying time has been completed.
However, there are some papers that cannot be cut, such as canvas or very thick paper, even when
the Form feed and cut key is pressed.
If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any
obstacles.
If the cutter is turned off, or the paper selected is canvas, the Form feed and cut key only advances the
paper. Use this key to move the print far enough out of the front of the printer, until it is convenient to
manually cut with a straight edge or scissors.

The roll is loose on the spindle
The roll may need to be replaced or reloaded. If your roll has a three-inch cardboard core, ensure the
core adaptors supplied with the printer have been installed, see Load a roll onto the spindle
on page 25.

A strip stays on the output tray and generates jams
If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a fullbleed print or after the Form feed and cut key has been pressed, the cut strip remains in the output tray.
Only when the printer is not working, reach in the tray and remove the strip.

Recalibrate the paper advance
Accurate paper advance is important to image quality because it is part of controlling the proper
placement of dots on the paper. If the paper is not advanced the proper distance between printhead
passes, light or dark bands appear in the print and image grain may increase.
The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you
select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing.
However, if you are using custom paper or not satisfied with the default calibration of your paper, you
may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality
issues on page 121 for steps to determine if paper advance calibration will solve your issue.
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The cutter does not cut well
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You can check the paper advance calibration status of the currently loaded paper at any time by pressing
the View loaded paper key on the front panel. The status may be one of the following.
●

DEFAULT: This status appears when loading an HP paper. HP papers in the Front Panel have
been optimized by default and unless you experience image quality problems in your printed image
such as banding or graininess it is not recommended to recalibrate the paper advance.

●

RECOMMENDED: This status appears when a new paper is created. The paper advance values
for this paper are inherited from the family type. In these cases it is recommended you perform a
paper advance calibration to optimize the values.

●

OK: This status indicates that the loaded paper has been calibrated before. However you may need
to repeat the calibration if you experience image quality problems such as banding or graininess
in your printed image.
NOTE: Whenever you update the printer’s firmware, the paper advance calibration values will be
reset to factory default, see Update the firmware on page 100.

CAUTION: Transparent papers and films must be calibrated using the Image Quality Maintenance
menu, Advance > Adjust paper advance, from step four in the Recalibrating the paper advance
procedure.

Recalibrating the paper advance procedure
1.

Press the Menu key to return to the main menu and select the Image Quality Maintenance menu
, then Calibrate paper advance. The printer automatically recalibrates the paper advance
icon
and prints a paper advance calibration image.

2.

Wait until the front panel displays the status screen and re-print your print.
NOTE: The recalibration procedure takes approximately three minutes. Do not worry about the
paper advance calibration image. The front-panel display shows any errors in the process.
If you are satisfied with your print continue using this calibration for your paper type. If you see
improvement in your print, continue with step three. If you are dissatisfied with the recalibration,
return to the default calibration, see Return to default calibration on page 120.

3.

If you would like to fine-tune the calibration or are using a transparent paper, press the Menu key
to return to the main menu and select the Image Quality Maintenance menu icon
Advance > Adjust paper advance.

, then

4.

Select the percentage of change from -100% to 100%. To correct light banding, decrease the
percentage. To correct dark banding, increase the percentage.

5.

Press the OK key on the front panel, to save the value.

6.

Wait until the front panel displays the status screen and re-print your print.

Return to default calibration
Returning to the default calibration sets all the corrections made by the paper advance calibration to
zero. To return to the default paper advance calibration value, you must reset the calibration.
1.

Press the Menu key to return to the main menu and select the Image Quality Maintenance menu
icon

2.

, then Advance > Reset paper advance

Wait until the front panel displays the operation has completed successfully before pressing the
Back key to return to the main menu.
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●

General advice

●

Print quality troubleshooting wizard

●

Horizontal lines across the image (banding)

●

Lines are too thick, too thin, or missing

●

Lines appear stepped or jagged

●

Lines print double or in the wrong colors

●

Lines are discontinuous

●

Lines are blurred

●

The whole image is blurry or grainy

●

The paper is not flat

●

The print is scuffed or scratched

●

Ink marks on the paper

●

Edges of objects are stepped or not sharp

●

Edges of objects are darker than expected

●

Bronzing

●

Black and white prints do not look neutral

●

Horizontal lines at the end of a cut sheet print

●

Vertical lines of different colors

●

White spots on the print

●

Colors are inaccurate

●

The image is incomplete (clipped at the bottom)

●

The image is clipped

●

Some objects are missing from the printed image

●

A PDF file is clipped or objects are missing

●

The Image Diagnostics Print

●

If you still have a problem
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General advice
When you have any print-quality problem:
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●

To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Order paper
on page 104.

●

Make sure that the paper type selected in the front panel is the same as the paper type loaded into
the printer. To check this, use the View loaded paper key on the front panel. At the same time,
check that the paper type has been calibrated. Also make sure that the paper type selected in your
software is the same as the paper type loaded into the printer.
CAUTION: If you have the wrong paper type selected, you could experience poor print quality
and incorrect colors, and perhaps even damage to the printheads.

●

Check that you are using the most appropriate print-quality settings for your purposes (see
Printing on page 41). You are likely to see lower print quality if you have moved the print-quality
slider to the 'Speed' end of the scale, or set the custom quality level to Fast.

●

Check that your environmental conditions (temperature, humidity) are in the recommended range.
See Environmental specifications on page 164.

●

Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain
the ink cartridges on page 99.

Print quality troubleshooting wizard
The Print Quality Troubleshooting Wizard can help with the following problems:
●

Horizontal lines across the image (banding)

●

The whole image is blurry or grainy

●

Lines are too thick, too thin, or missing

●

Colors are inaccurate

To start the wizard:
●

From HP Easy Printer Care under Windows: go to the Support tab, and select Print quality
troubleshooting.

●

From HP Printer Utility under Mac OS: select Support, then Print quality troubleshooting.

●

From the Mac OS Print dialog: go to the Services panel, select Device Maintenance, then
select Print quality troubleshooting from the list of maintenance tasks.

●

From the Embedded Web Server: go to the Support tab, select Troubleshooting, then select
Print quality troubleshooting.

122 Chapter 12 Troubleshooting print-quality issues

ENWW

Horizontal lines across the image (banding)
If your printed image suffers from added horizontal lines as shown (the color may vary):

ENWW

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2.

Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 41). In some cases, you can overcome a print-quality problem merely by selecting a higher
print-quality level. For instance, if you have set the Print Quality slider to Speed, try setting it to
Quality; if you have already set it to Quality, try selecting custom options and then More
Passes. If you change the print-quality settings, you may wish to reprint your job at this point in
case the problem has been solved.

3.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

4.

If the printheads are working correctly, go to the front panel and press the View loaded paper key
to see the paper advance calibration status. If the status is RECOMMENDED, you should perform
paper advance calibration: see Recalibrate the paper advance on page 119.
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Alternatively, or if you have other print quality problems, you can continue reading this chapter.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines are too thick, too thin, or missing
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1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2.

Check that you are using appropriate print-quality settings for your purposes (see Printing
on page 41). Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and
try turning on the Maximum detail option. You may wish to reprint your job at this point in case
the problem has been solved.

3.

If the resolution of your image is greater than the printing resolution, you may notice a loss of line
quality. You can find the Max. Application Resolution option in the Windows driver dialog's
Advanced tab, under Document Options > Printer Features. If you change this option, you may
wish to reprint your job at this point in case the problem has been solved.

4.

If lines are too thin or missing, print the Image Diagnostics Print. See The Image Diagnostics
Print on page 133.

5.
If the problem remains, go to the front panel and select the Ink menu icon
, then Printhead
information to see the printhead alignment status. If the status is PENDING, you should align the
printheads. See Align the printheads on page 142. After alignment, you may wish to reprint your
job in case the problem has been solved.
6.

Go to the front panel and press the View loaded paper key to see the paper advance calibration
status. If the status is RECOMMENDED, you should perform paper advance calibration: see
Recalibrate the paper advance on page 119.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Lines appear stepped or jagged
If lines in your image appear stepped or jagged when printed:
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The problem may be inherent in the image. Try to improve the image with the application you are
using to edit it.

2.

Check that you are using appropriate print-quality settings. See Printing on page 41.

3.

Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and turn on the
Maximum detail option.

4.

Change your image rendering resolution to 300 dpi or 600 dpi depending on your printing needs.
You can find the Max. Application Resolution option in the Windows driver dialog's Advanced
tab, under Document Options > Printer Features.

Lines print double or in the wrong colors
This problem can have various visible symptoms:
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●

Colored lines are printed double, in different colors.

●

The borders of colored blocks are wrongly colored.
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1.

To correct this kind of problem:
1.

Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 86 and Insert a printhead on page 88.

2.

Align the printheads. See Align the printheads on page 142.

Lines are discontinuous
If your lines are broken in the following way:
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1.

Check that you are using appropriate print-quality settings. See Printing on page 41.

2.

Reseat the printheads by removing them and then reinserting them. See Remove a printhead
on page 86 and Insert a printhead on page 88.

3.

Align the printheads. See Align the printheads on page 142.

Lines are blurred

Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy. Try the following:
1.

Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 164.

2.

Check that the paper type selected in the front panel is the same as the paper type you are using.
To check on the front panel, use the View loaded paper key.

3.

Try changing to a heavier paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper, or Digital Fine Art paper.

4.

If you are using glossy paper, try changing to a different type of glossy paper.
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5.

Select the custom print-quality options in the driver dialog (Mac OS Print dialog), and turn on the
More passes option.

6.

Align the printheads. See Align the printheads on page 142.
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The whole image is blurry or grainy

1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2.

Check that you are printing on the correct side of the paper.

3.

Check that you are using appropriate print-quality settings (see Printing on page 41). In some
cases, you can overcome a print-quality problem merely by selecting a higher print-quality level.
For instance, if you have set the Print Quality slider to Speed, try setting it to Quality; if you have
already set it to Quality, try selecting custom options and then More Passes. If you change the
print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

4.
, then Printhead information to see the
Go to the front panel and select the Ink menu icon
printhead alignment status. If the status is PENDING, you should align the printheads. See Align
the printheads on page 142. After alignment, you may wish to reprint your job in case the problem
has been solved.
5.

Go to the front panel and press the View loaded paper key to see the paper advance calibration
status. If the status is RECOMMENDED, you should perform paper advance calibration: see
Recalibrate the paper advance on page 119.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

The paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely
to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper
that becomes saturated with ink.
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1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper, or thicker Digital Fine Art papers.

The print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen, or some other
object. This is particularly noticeable on coated paper, matte proofing paper, and fine art material.
Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after
printing, depending on the amount of ink used and the environmental conditions at the time of printing.
To reduce the risk of scuffs and scratches:
●

Handle prints carefully.

●

Avoid stacking prints on top of each other.

●

Disable the automatic cutter before printing, so that the print will not fall into the basket. See Turn
the automatic cutter on and off on page 38. Alternatively, leave a sheet of paper in the basket so
that freshly printed sheets do not make direct contact with the basket.

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the
printheads move over the paper, the printheads may come into contact with the paper and smear the
printed image. This problem is normally seen only on cut sheets of paper (not on roll paper).
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Try the following suggestions to avoid this problem:
1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key.

2.

Use a recommended paper type (see Order paper on page 104) and the correct print settings.

3.

If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may
affect performance.

4.

Try changing to a thicker paper type, such as HP Heavyweight Coated Paper, HP Super
Heavyweight Coated Paper, or thicker Digital Fine Art papers.

5.

Try to increase the margins by relocating the image to the center of the page using your software
application.

Ink marks on the back of the paper
This can happen after a lot of borderless printing, especially with non-standard paper sizes. Ink residues
on the platen are likely to mark the back of the paper.
Clean the platen with a soft cloth. Clean each rib separately without touching the foam between the ribs.

Edges of objects are stepped or not sharp

If edges of objects or lines appear to be poorly defined or lighter in density, and you have already set
the print-quality slider to Quality in the driver dialog (Mac OS Print dialog), select the custom print-quality
options, and try setting the quality level to Normal. See Printing on page 41.
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Whenever you notice this problem, cancel the printing job immediately. Press the Cancel key and also
cancel the job from your computer application. Soaked paper can damage the printheads.

Edges of objects are darker than expected
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If edges of objects seem darker than expected, and you have already set the print-quality slider to
Quality in the driver dialog (Mac OS Print dialog), select the custom print-quality options, and try setting
the quality level to Normal. See Printing on page 41.

Bronzing
If you are printing on photo paper with gray and black ink only, and you experience a gloss differential
problem when fluorescent light is directly reflected towards you from the print, producing 'bronzed'
reflections from the ink, try one of the following:
●

Use the Full set of inks option (see Print in gray shades on page 49)

●

Display the print vertically or behind glass

Black and white prints do not look neutral
Consider using the Gray and Black inks only only. See Print in gray shades on page 49.

Horizontal lines at the end of a cut sheet print
This type of defect affects only the end of a print, within approximately 30 mm of the trailing edge of the
paper. You may see some very thin horizontal lines across the print.
To avoid this problem:
1.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

2.

Consider printing with roll paper.

3.

Consider using larger margins around your image.

Vertical lines of different colors
If your print has vertical bands of different colors along it:
1.

Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight
Coated Paper and HP Super Heavyweight Paper. See Order paper on page 104.

2.

Try using higher print-quality settings (see Printing on page 41). For instance, if you have set the
Print Quality slider to Speed, try setting it to Quality; if you have already set it to Quality, try
selecting custom options and then More Passes.
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White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust, or loose coating
material. To avoid this problem:
Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

2.

Always keep the cover of your printer closed.

3.

Protect your paper rolls and sheets by storing them in bags or boxes.

Troubleshooting printquality issues

1.

Colors are inaccurate

If the colors of your print do not match your expectations, try the following:
1.

Check that the paper type you have loaded corresponds to the paper type selected in the front
panel and in your software. To check on the front panel, use the View loaded paper key. At the
same time, check the color calibration status. If the status is PENDING or OBSOLETE, you should
perform color calibration: see Color calibration on page 58. If you have made any changes, you
may wish to reprint your job in case the problem has been solved.

2.

Check that you are printing on the correct side of the paper.

3.

Check that you are using appropriate print-quality settings (see Printing on page 41). If you have
selected the Speed or Fast options, you may not get the most accurate colors. If you change the
print-quality settings, you may wish to reprint your job at this point in case the problem has been
solved.

4.

If you are using Application Color Management, check that the color profile you are using
corresponds to the selected paper type and print-quality settings. If you have doubts about which
color settings to use, see Color management on page 51. If you need to create a color profile,
see Color profiling on page 59.

5.

If the problem consists of color differences between your print and your monitor, please follow the
instructions in the “How to calibrate your monitor” section of the HP Color Center. At this point, you
may wish to reprint your job in case the problem has been solved.

6.

Print the Image Diagnostics Print. See The Image Diagnostics Print on page 133.

If the problem persists despite all the above actions, contact your customer service representative for
further support.

Color accuracy using EPS or PDF images in page layout applications
Page layout applications such as Adobe InDesign and QuarkXPress do not support color management
of EPS, PDF, or grayscale files.
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If you have to use such files, try to ensure that the EPS, PDF, or grayscale images are already in the
same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if
your final goal is to print the job in a press that follows the SWOP standard, convert the image into SWOP
when you create it.

The image is incomplete (clipped at the bottom)
Troubleshooting printquality issues

●

Did you press Cancel before all the data were received by the printer? If so, you have ended the
data transmission and will have to print the page again.

●

The I/O timeout setting may be too short. This setting determines how long the printer waits for
the computer to send more data, before deciding that the job is finished. From the front panel,
increase the I/O timeout setting to a longer period and then send the print again. From the
Connectivity menu

, select Advanced > Select I/O timeout.

●

There may be a communications problem between your computer and the printer. Check your USB
or network cable.

●

Check to make sure that your software settings are correct for your current page size (for example,
long-axis prints).

●

If you are using network software, make sure it has not timed out.

The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as understood by your software. You can often identify this kind of problem before
printing by previewing your print (see Preview a print on page 45).
●

Check the actual printable area for the paper size you have loaded.
printable area = paper size – margins

●

Check what your software understands to be the printable area (which it may call "printing area"
or "imageable area"). For example, some software applications assume standard printable areas
that are larger than those used in this printer.

●

If you have defined a custom page size with very narrow margins, the printer may impose its own
minimal margins, clipping your image slightly. You may want to consider using a larger paper size,
or borderless printing (see Select margins options on page 43).

●

If your image contains its own margins, you may be able to print it successfully by using the Clip
Contents by Margins option (see Select margins options on page 43).

●

If you are trying to print a very long image on a roll, check that your software is capable of printing
an image of that size.

●

You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

●

If necessary, reduce the size of the image or document in your software application, so it fits
between the margins.

There is another possible explanation for a clipped image. Some applications, such as Adobe
Photoshop, Adobe Illustrator, and CorelDRAW, use an internal 16-bit coordinate system which means
that they cannot handle an image of more than 32,768 pixels. If you try to print an image larger than this
from these applications, the bottom of the image will be clipped. In this case, the only way to print the
whole image is to reduce the resolution so that the whole image requires fewer than 32,768 pixels. The
Windows driver dialog includes an option called 16-bit App. Compatibility, which can be used to reduce
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the resolution of such images automatically. You can find this option in the Advanced tab, under
Document Options > Printer Features.

Some objects are missing from the printed image

●

In the Advanced tab, select Document options, Printer features, and set Send job as bitmap
to Enabled (HP-GL/2 driver only).

●

In the Advanced tab, select Document options, Printer features, and set 16-bit App.
Compatibility to Enabled.

●

In the Advanced tab, select Document options, Printer features, and set Max. Application
resolution to 300.

The above settings are mentioned for troubleshooting purposes and may adversely affect the final output
quality or the time necessary to generate the print job. Therefore, they should be restored to their default
values if they do not help to solve the problem.
If you are working under Mac OS, the above settings are not available. Instead, you could try reducing
the resolution of bitmap images in your application software.

A PDF file is clipped or objects are missing
In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some
objects when printing with the HP-GL/2 driver at high resolution. In order to avoid such problems,
upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From version 7 onwards,
these problems should be solved.

The Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It
helps you to check the performance of the printheads that are currently installed in your printer, and
whether any printhead suffers from clogging or other problems.
To print the Image Diagnostics Print:
1.

Use the same paper type that you were using when you detected a problem.

2.

Use the View loaded paper key on the front panel to check that the selected paper type is the same
as the paper type loaded into the printer.

3.
At the printer's front panel, select the Image Quality Maintenance menu icon
diagnostic image.

, then Print

It takes about two minutes to print the Image Diagnostics Print.
The print is divided into two parts, both of which test printhead performance.
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●

Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the
print quality that you will get from each color.

●

Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part
complements the first, and aims more specifically to detect how many faulty nozzles each printhead
has.

Some objects are missing from the printed image 133
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Large quantities of data may be necessary to print a high-quality large-format print job, and in some
specific workflows there may be issues that can lead to some objects missing from the output. Here are
some recommendations for the use of the Windows driver dialog in these cases.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the
center of the patterns of dashes.

Troubleshooting printquality issues
First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without
any horizontal lines across it.
Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most
of the dashes are present.
If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.
Here is an example of a light gray printhead in a good state:

And here is an example of the same printhead in a bad state:
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1.

Clean any faulty printheads (see Clean the printheads on page 139). Then reprint the Image
Diagnostics Print to see whether the problem has been solved.

2.

If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see
whether the problem has been solved.

3.

If the problem remains, consider cleaning your printheads manually (see Clean the printheads
on page 139). You could also try reprinting your current print job, in case it now prints satisfactorily.

4.

If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you
when this is necessary, but it may be worth trying even if the printer has not suggested it. See
Clean the printhead drop detector on page 140.

5.

If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges
and printheads on page 81), or contact HP Support (see Contact HP Support on page 158).

If you still have a problem
If you still experience print-quality problems after applying the advice in this chapter, here are some
further things that you can do:
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●

Try using a higher print-quality option. See Printing on page 41.

●

Check the driver you are using to print with. If it is a non-HP driver, consult the driver vendor about
the problem. You could also try using the correct HP driver, if feasible. The latest HP drivers can
be downloaded from http://www.hp.com/go/designjet/.

●

If you are using a non-HP RIP, its settings may be incorrect. See the documentation that came with
the RIP.

●

Check that your printer's firmware is up to date. See Update the firmware on page 100.

●

Check that you have the right settings in your software application.
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Corrective action
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●

Cannot insert an ink cartridge

●

Ink cartridge status messages

●

Cannot insert a printhead

●

The front-panel display recommends reseating or replacing a printhead

●

Clean the printheads

●

Clean the printhead drop detector

●

Align the printheads

●

Printhead status messages

Troubleshooting ink
cartridge and printhead
issues
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Cannot insert an ink cartridge
1.

Check that you have the correct type of cartridge (model number).

2.

Check that the colored label on the cartridge is the same color as the label on the slot.

3.

Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label
right-side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
These are the possible ink cartridge status messages:
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cartridge and printhead
issues

●

OK: the cartridge is working normally, with no known problems.

●

Missing: there is no cartridge present, or it is not correctly connected to the printer.

●

Low: the ink level is low.

●

Very low: the ink level is very low.

●

Empty: the cartridge is empty.

●

Reseat: you are recommended to remove the cartridge and then reinsert it.

●

Replace: you are recommended to replace the cartridge with a new cartridge.

●

Altered: there is something unexpected about the cartridge's status.

●

Expired: it is past the cartridge's expiration date.

Cannot insert a printhead
1.

Check that you have the correct type of printhead (model number).

2.

Check that you have removed the two orange protective caps from the printhead.

3.

Check that the colored label on the printhead is the same color as the label on the slot.

4.

Check that the printhead is correctly oriented (compare with the others).

5.

Check that you have correctly closed and latched the carriage lid, see Insert a printhead
on page 88.
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The front-panel display recommends reseating or
replacing a printhead
1.

From the front panel, turn the power off then on.

2.

Check the front-panel display message, if it shows the ready message, the printer is ready to print.
If the problem remains continue with the next step.

3.

Remove the printhead, see Remove a printhead on page 86.

4.

Clean the electrical connections on the backside of the printhead with a lint free cloth. You can
carefully use de-ionized or distilled water if moisture is needed to remove residue.

5.

Reinsert the printhead, see Insert a printhead on page 88.

6.

Check the front-panel display message. If the problem remains, try a new printhead.

Clean the printheads
As long as the printer is kept turned on, an automatic cleaning is performed periodically. This ensures
there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If you have
not already done so, please see The Image Diagnostics Print on page 133 before proceeding.
To clean the printheads, press the Menu key to return to the main menu and select the Image Quality
, then Clean printheads. If you have gone through the Image Quality
Maintenance menu icon
Diagnostic print process, you know which colors are failing. Select to the pair of printheads which contain
the failing colors. If you are not sure which colors to clean, you can also select to clean all printheads.
Cleaning all printheads takes about nine minutes. Cleaning a single pair of printheads takes about six
minutes.
NOTE:

Cleaning all printheads uses more ink than cleaning a single pair.

If you have cleaned the printheads using the Clean printheads procedure from the front panel and are
still experiencing image quality problems, you can try cleaning the printhead nozzles manually using the
following procedure.
WARNING! This is a delicate process and may damage the printhead. Do not touch the electrical
connections on the backside of the printhead.
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WARNING! This is a delicate process and may damage the printhead. Do not touch the nozzles
on the bottom side of the printhead.

Must remove the printhead (see Remove a printhead on page 86) and using a cotton swab and a little
de-ionized or distilled water, clean the bottom of the printhead until the residue is removed.

Clean the printhead drop detector

Troubleshooting ink
cartridge and printhead
issues

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in
order to substitute them for good printing nozzles. If particles, such as fibers, hair, or paper pieces, block
the sensor print quality is affected.
When the front panel displays a warning message that the clean process is needed, you are
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector
immediately, the printer continues working normally, however, the front panel display continues to show
the warning.
CAUTION: Wear gloves to avoid getting ink on your hands.

1.

Turn off the printer at the front panel.
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To avoid an electric shock, switch the printer off and unplugged it.

3.

Open the transparent window.

4.

Find the printhead drop detector beside the stored printhead carriage.

5.

Remove any debris blocking the printhead drop detector.

6.

With a dry lint free cloth, wipe the surface of the drop detector to remove any non-visible debris.
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7.

Close the window.

8.

Plug in and switch on the printer.

9.

Power the printer on at the front panel.

Align the printheads
Precise alignment between printheads is essential for accurate colors, smooth color transitions, and
sharp edges in graphical elements. Your printer has an automatic printhead alignment process which
runs whenever a printhead has been accessed or replaced.
In cases where the paper has jammed, you have used a custom paper, or are experiencing problems
with color accuracy (see Color management on page 51); you may need to align the printheads.
NOTE: If the paper has jammed, it is recommended that you reinsert the printheads and initiate the
realignment procedure with the Image Quality Maintenance menu

.

TIP: Photo paper is recommended for the best quality; plain, bond and thin coated papers provide
acceptable but marginal results.
WARNING! Do not use transparent or semi-transparent paper to align the printheads.
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Reinsert printheads procedure
1.

If the realignment process is running and the wrong paper is loaded, press the Cancel key on the
front panel.
CAUTION: Do not print if the realignment process has been canceled. You can restart the
alignment with the Image Quality Maintenance menu procedure.

2.

Load the paper you wish to use, see Paper handling on page 23. You can use a roll or cut sheet,
however, it must be A3 landscape or larger (420 by 297 mm). Photo paper is recommended for
the best results.
NOTE: If you are using an A3 cut sheet, ensure it is loaded so the larger side feeds into the
printer.

3.

Remove and re-insert all the printheads, see Remove a printhead on page 86 and Insert a
printhead on page 88. This starts the printhead alignment procedure.

4.

Ensure the transparent window is closed, as a strong light source near the printer during printhead
realignment can affect alignment.

5.

The process takes about six minutes. Wait until the front-panel display shows the process complete
before using the printer.
NOTE: The printer prints a calibration image. Do not worry about the image. The front-panel
display shows any errors in the process.

Image Quality Maintenance menu procedure
1.

Load the paper you wish to use, see Paper handling on page 23. You can use a roll or cut sheet,
however, it must be A3 landscape or larger (420 by 297 mm). Photo paper is recommended for
the best results; plain, bond and thin coated papers provide acceptable but marginal results.
NOTE: If you are using an A3 cut sheet, ensure it is loaded so the larger side feeds into the
printer.
WARNING! Do not use transparent or semi-transparent paper to align the printheads.

2.

Press the Menu key to return to the main menu and select the Image Quality Maintenance menu
, then Align printheads. The printer checks to see if it has enough paper to run the
icon
realignment.
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WARNING! Do not use transparent or semi-transparent paper to align the printheads.

3.

If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern.
Ensure the transparent window is closed, as a strong light source near the printer during printhead
realignment can affect alignment.

4.

The process takes about five minutes. Wait until the front-panel display shows the process
complete before using the printer.

Scanning errors during alignment
If the alignment process fails, a Scanning problems message appears on the front panel. This means
that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment
should be repeated before printing with good image quality. The problem may be due to:
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●

The paper used was not valid, repeat the alignment with valid paper

●

Printhead health problems, clean printheads, see Clean the printheads on page 139

●

The alignment was done with the transparent window open, repeat the alignment with the window
closed

If the problem persists after using valid paper, cleaning the printheads, and keeping the window closed,
there may be a failure in the scanning system needing reparation or the printheads, although clean, may
not work and need to be replaced.

Printhead status messages
These are the possible printhead status messages:
●

OK: the printhead is working normally, with no known problems

●

Missing: there is no printhead present, or it is not correctly installed in the printer.

●

Test printhead separately: you are recommended to test the printheads individually to find the
failing printhead. Remove all the printheads and insert them alone one by one, closing the latch
and the carriage lid after every insertion. The front-panel display indicates the failing one showing
the reseat or replace message.

●

Reseat: you are recommended to remove the printhead and then reinsert it. If that fails, clean the
electrical connections, see The front-panel display recommends reseating or replacing a
printhead on page 139. If that fails, replace the printhead with a new printhead, see Remove a
printhead on page 86 and Insert a printhead on page 88.

●

Replace: the printhead is failing. Replace the printhead with a working printhead, see Remove a
printhead on page 86 and Insert a printhead on page 88.

●

Replacement incomplete: a printhead replacement process has not completed successfully, relaunch the replacement process and let it finish completely (it is not needed to change the
printheads).

●

Remove: the printhead is not a suitable type for use in printing.
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The printer does not print

●

The printer seems slow

●

Communication failures between computer and printer

●

Cannot access HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS)

●

Cannot access the Embedded Web Server

●

Automatic file system check

●

An AutoCAD 2000 memory allocation error

●

No output when printing from Microsoft Visio 2003

●

Unavailable driver features when printing from QuarkXPress

●

Printer alerts
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●
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The printer does not print
If all is in order (paper loaded, all ink components installed, and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected:
●

You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

●

You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic
fields or severe electrical disturbances, which can cause the printer to behave strangely or even
stop working. In this case, turn off the printer using the Power key on the front panel and unplug
the power cord, wait until the electromagnetic environment has returned to normal, then turn it on
again. If you still experience problems, please contact your customer service representative.

●

You may have the wrong graphic language setting, see Change the graphic language setting
on page 22.

●

You may not have installed in your computer the correct driver for your printer, see the Setup
instructions.

●

If you are printing on a sheet, you must specify sheet as the paper source in HP Easy Printer Care
(Windows) or HP Printer Utility (Mac OS).

●

You may have requested a print preview from your printer driver. This is a function you can use to
check that the image is the one you want. In this case, the preview is displayed on your screen,
and you must click the Print button to start printing.

The printer seems slow
Here are some possible explanations.
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●

Did you set the print quality to Best or Max Detail? Best-quality and maximum detail prints take
longer as they require more passes.

●

Did you specify the correct paper type when loading the paper? Photo and coated papers require
more drying time between passes. To find out the printer's current paper type setting, see View
information about the paper on page 36. Some paper types require more time for printing.

●

Do you have a network connection to your printer? Check that all components used in the network
(network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is
there a lot of traffic from other devices on the network?

●

Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Communication failures between computer and printer
Some symptoms are:
●

The front-panel display does not show the Receiving message when you have sent an image to
the printer.

●

Your computer displays an error message when you are trying to print.

●

Your computer or printer hangs (stays idle), while communication is taking place.

●

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)
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To solve a communication problem:
●

Ensure that you have selected the correct printer in your application, see Printing on page 41.

●

Ensure that the printer works correctly when printing from other applications.

●

Remember that very large prints may take some time to receive, process, and print.

●

If the printer is connected to a network, try using it when connected directly to your computer
through a USB cable.

●

If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to
your computer.

●

Try another interface cable.

●

Ensure that the graphic language setting is correct, see Change the graphic language setting
on page 22.

●

If the printer is connected with a USB, try to disconnect and reconnect the USB cable with the
computer.

Cannot access HP Easy Printer Care (Windows) or HP
Printer Utility (Mac OS)
If you have not done so already, please read Access HP Easy Printer Care (Windows) or HP Printer
Utility (Mac OS) on page 19.
NOTE: Windows XP Professional x64 Edition does not support HP Easy Printer Care, therefore it
cannot be installed by your printer's installer.
1.
.

2.

Select Advanced > Web Services > Printer Utility Software > Enable.

3.

If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu
and select the Connectivity menu icon

again.

4.

Select the type of connection you are using.

5.

Select View Information.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Cannot access the Embedded Web Server
If you have not done so already, please read Access the Embedded Web Server on page 19.
NOTE: If you connect directly to your printer with a USB cable, use HP Easy Printer Care (Windows)
or HP Printer Utility (Mac OS).
1.
Press the Menu key to return to the main menu and select the Connectivity menu icon
2.

Select Advanced > Allow EWS > On.

3.

If you have a TCP/IP connection to your printer, press the Menu key to return to the main menu
and select the Connectivity menu icon
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again.
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Press the Menu key to return to the main menu and select the Connectivity menu icon

4.

Select the type of connection you are using.

5.

Select View Information.

6.

Ensure that you see IP enabled. If not, you may need to use a different connection.

If you are using a proxy server, try bypassing the server and accessing the Web server directly.
●

In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN
Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more
precise control, click the Advanced button and add the printer's IP address to the list of exceptions,
for which the proxy server is not used.

●

In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change
Settings button. Add the printer's IP address or its domain name to the list of exceptions, for which
the proxy server is not used.

If you still cannot connect, switch the printer off and back on with the Power key on the front panel.

Automatic file system check
When you turn on the printer, you will occasionally see a front panel display similar to the one shown
below.
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A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.
CAUTION: If you turn the printer off before the file system check has finished, the file system could
be seriously damaged, making the printer's hard disk unusable. In any case, the file system check will
restart from the beginning whenever you turn the printer on again.
A file system check is scheduled every 90 days, in order to maintain the hard disk's file system integrity.

An AutoCAD 2000 memory allocation error
After installing the printer driver, when you try to print for the first time from AutoCAD 2000, you may
see a message saying Memory allocation error, after which your image is not printed.
This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the Plotting Update Patch
(plotupdate.exe) from the Autodesk Web site, http://www.autodesk.com/.
This patch is also worth trying if you have any other strange problems when printing from AutoCAD
2000.

No output when printing from Microsoft Visio 2003
For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base (http://support.microsoft.com/search/).
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To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 129 inches
and then to scale the drawing up in the driver by using the Scale to options in the Effects tab of the
Windows driver. If the down-scaling in the application and the up-scaling in the driver match, the result
is as originally intended.

Unavailable driver features when printing from
QuarkXPress
When you print from QuarkXPress, the following driver features are not available.
●

Print Preview

●

Rotation

●

Scaling

●

Office features or paper saving options

●

Back to front printing

If you are using the HP-GL/2 driver, the following features are not available.
●

Print Preview

●

Back to front printing

To get the same results, use the equivalent features available in QuarkXPress.

Printer alerts
●

Errors: Mainly alerting you to the fact that the printer is unable to print. However, in the driver,
errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer
is able to print.

●

Warnings: Alert you when the printer needs attention either for an adjustment, such a calibration
or for a possible unprintable situation, such a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system.
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●

Front-panel display: The front panel only shows the most relevant alert at a time. It generally
requires the user to press the OK key for confirmation, but in the case of a warning, it disappears
after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when
the printer becomes idle and there is not another more severe alert.

●

HP Easy Printer Care (Windows) or HP Printer Utility (Mac OS): These applications have a
section in the Overview tab called "Items needing attention". All the alerts currently present in the
printer are listed under this section. If alerts are enabled and there is a problem that prevents
printing, the user is shown a pop-up window that explains why the printer is not going to print. These
pop-up alerts are configurable also as desktop alerts.

●

Embedded Web Server: The upper-right corner of the EWS screen shows the Printer status. If
there is an alert in the printer, the status shows the alert text. Both the front-panel display and the
EWS show the same alert.

●

Driver: The driver shows alerts. The driver warns about job configuration settings that may produce
a problem in the final output. If the printer is not ready to print, it displays a warning.
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Your printer can communicate are two types of alerts:
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15 Front-panel error messages

Occasionally you may see one of the following messages appear on the front-panel display. If so, please
follow the advice in the Recommendation column.
If you see an error message that does not appear here, and you feel in doubt about the correct response,
contact HP Support. See Contact HP Support on page 158.
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Message

Recommendation

[Color] cartridge has expired

Replace the cartridge. See Handling ink cartridges and
printheads on page 81.

[Color] cartridge is missing

Insert a cartridge of the correct color. See Handling ink
cartridges and printheads on page 81.

[Color] cartridge is out of ink

Replace the cartridge. See Handling ink cartridges and
printheads on page 81.

[Color] printhead #[n] error: not present

Insert the correct printhead. See Handling ink cartridges and
printheads on page 81.

[Color] printhead #[n] error: please remove

Remove the incorrect printhead and insert a new printhead of
the correct type (color and number). See Handling ink
cartridges and printheads on page 81.

[Color] printhead #[n] error: replace

Remove the non-functional printhead and insert a new
printhead. See Handling ink cartridges and printheads
on page 81.

[Color] printhead #[n] error: reseat

Remove and reinsert the same printhead, or try cleaning the
electrical connections. If necessary, insert a new printhead.
See The front-panel display recommends reseating or
replacing a printhead on page 139.

[Color] printhead #[n] out of warranty

The printhead's warranty has expired, because of the length of
time it has been in operation or because of the volume of ink
used.

[Color] printhead #[n] warranty warning

The printhead's warranty may be invalidated by the use of the
wrong kind of ink.

IO error

Restart the printer. If the problem persists, contact HP Support.
See Contact HP Support on page 158.

IO warning

Try again; if the problem persists, contact HP Support. See
Contact HP Support on page 158.

Paper advance calibration pending

Perform paper advance calibration. See Recalibrate the paper
advance on page 119.

Paper too small to print paper advance calibration

Unload paper and load larger paper.

Paper too small to scan paper advance calibration

Unload paper and load larger paper.

PDL Error: Ink system not ready

Clean the printheads. See Clean the printheads on page 139.
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Table 15-1 Text messages

Table 15-1 Text messages (continued)
Message

Recommendation

PDL Error: Job clipped

The image is too large for the paper or for the printer. Load
larger paper if possible, or reduce the image size.

PDL Error: memory full

Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

PDL Error: out of paper

Load more paper.

PDL Error: parsing error

The print job is unintelligible to the printer. Try to recreate and
resend it. Check your cable connections.

PDL Error: print mode error

The paper type or print quality specified for the job are
incorrect. Change the loaded paper type or the print settings.

PDL Error: printing error

Try sending the job again.

PDL Error: virtual memory full

Restart the printer and try resending the job; if necessary,
reduce the complexity of the job.

Printhead alignment error: paper too small

Unload paper and load larger paper.

Replace [color] cartridge

Replace the cartridge. See Handling ink cartridges and
printheads on page 81.

Reseat [color] cartridge

Remove and reinsert the same cartridge. See Handling ink
cartridges and printheads on page 81.

Update: failed. Invalid file

Make sure that you have selected the correct firmware update
file. Then try again to perform the update.

Table 15-2 Numerical error codes
Error code

Recommendation

01.0

Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 158.

01.1
01.2
21

Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 158.

21.1
22.0
22.1
22.2
22.3
24

Front-panel error
messages

52:01

The printer needs internal cleaning. See Clean the printhead drop detector on page 140. If the
problem persists, contact HP Support. See Contact HP Support on page 158.

62

Update your printer's firmware. See Update the firmware on page 100.

63
64
65
67
74.1

Try the firmware update again. Do not try to use your computer while the update is in progress.
If the problem persists, contact HP Support. See Contact HP Support on page 158.
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Table 15-2 Numerical error codes (continued)
Error code

Recommendation

79

Restart the printer. If the problem persists, contact HP Support. See Contact HP Support
on page 158.

94

Restart color calibration. See Color calibration on page 58.
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94.1
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Introduction

●

HP Professional Graphics Services

●

HP Instant Support

●

HP Proactive Support

●

Contact HP Support
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Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet,
providing comprehensive, proven support expertise and new technologies to give you unique end-toend support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair
and exchange services, phone and Web support, software updates, and self-maintenance services. To
find out more about HP Customer Care, please visit us at:
http://www.hp.com/go/designjet/
or call us on the telephone (see Contact HP Support on page 158).

HP Professional Graphics Services
For further information on all the services described in this section, please visit http://www.hp.com/go/
pgs/.

Knowledge Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.
Join the HP community at the Knowledge Center, your large-format printing community at
http://www.hp.com/go/knowledge_center/djz2100/ for 24×7 access to:
●

Multimedia tutorials

●

Step-by-step how-to guides

●

Downloads — the latest printer firmware, drivers, software, paper profiles, etc.

●

Technical support — online troubleshooting, customer care contacts, and more

●

Workflows and detailed advice for completing various printing tasks from particular software
applications

●

Forums for direct contact with the experts, both HP and your colleagues

●

Warranty tracking online, for your peace of mind

●

Latest product information — printers, supplies, accessories, software, etc.

●

Supplies Center for all you need to know about ink and paper

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences, you decide the information you need.

HP Start-Up Kit
The HP Start-Up Kit is the DVD that comes with your printer; it contains the printer's software and
documentation, including introductory multimedia tutorials to help you to get a good first print.

HP Care Packs and Warranty Extensions
If you would like to extend your printer's warranty beyond the standard period, two methods are available.
●

An HP Care Pack provides support for a three-year period. You can buy it when you buy the printer,
or for a short time afterwards.

●

A one-year Warranty Extension can be bought at any time.
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●

Next business day

●

Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/lookuptool/.

HP Installation
The HP Installation service unpacks, sets up, and connects the printer for you.
This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/
lookuptool/.

HP Instant Support
HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic
information from your printer and match it with intelligent solutions from HP's knowledge bases, allowing
you to resolve problems as quickly as possible.
You can start an HP Instant Support session by clicking on the link provided by your printer's Embedded
Web Server. See Access the Embedded Web Server on page 19.
To be able to use HP Instant Support:
●

You must have a TCP/IP connection to your printer, because HP Instant Support is accessible only
through the Embedded Web Server.

●

You must have access to the World Wide Web, because HP Instant Support is a Web-based
service.

HP Instant Support is currently available in English, Korean, Simplified Chinese, and Traditional
Chinese.
You can find more information about HP Instant Support at http://www.hp.com/go/ispe/.

HP Proactive Support
HP Proactive Support helps reduce costly printer downtime by preemptively identifying, diagnosing, and
resolving printer issues before they become problems for you. HP's Proactive Support tool is designed
to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a
mouse.
A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control
of your printing environment—with a clear focus on maximizing the value of your investment, increasing
printer uptime, and reducing printer management costs.
HP recommends that you enable Proactive Support right away to save you time and prevent problems
before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for
software and firmware updates.
You can enable Proactive Support in HP Easy Printer Care for Windows or HP Printer Utility for Mac
OS, where you can specify the frequency of connections between your computer and HP's Web server,
and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time.
If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the
problem and recommend a solution. In some cases, the solution may be applied automatically; in other
cases, you may be asked to perform some procedure to solve the problem.
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HP Care Packs and Warranty Extensions include remote support. On-site service is also provided if
necessary, with two alternative response-time options.

HP Customer Care

Contact HP Support
HP Support is available to you by telephone. What to do before you call:
●

Review the troubleshooting suggestions in this guide.

●

Review the relevant driver documentation.

●

If you have installed third-party software drivers and RIPs, see their documentation.

●

If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:
◦

The printer you are using (the product number and the serial number, found on the label at
the back of the printer)

◦

If there is an error code on the front panel, note it down; see Front-panel error messages
on page 151

◦

The printer's Service ID: at the front panel, select the Information menu icon
printer information

, then View

◦

The computer you are using

◦

Any special equipment or software you are using (for example, spoolers, networks, switchboxes, modems, or special software drivers)

◦

The cable you are using (by part number) and where you purchased it

◦

The type of interface used on your printer (USB or network)

◦

The software name and version you are currently using

◦

If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report, and “all pages above” from Service Information
(see The printer's internal prints on page 7)

Telephone numbers
An up-to-date list of HP Support telephone numbers is available on the Web: please visit
http://welcome.hp.com/country/us/en/wwcontact_us.html. If you have no access to the Web, try one of
the numbers below.
●

Algeria: 213 17 63 80

●

Argentina: 0 800 777 HP INVENT, local 5411 4778 8380

●

Australia: 13 10 47

●

Austria: 0810 00 10 00

●

Bahrain: 800 171

●

Belgium: (0) 78 600 600

●

Bolivia: 0 800 1110, local 54 11 4708 1600

●

Brazil: 0800 157 751, local 55 11 3747 7799

●

Canada: 1 800 HP INVENT

●

Caribbean: 1 800 711 2884
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Central America: 1 800 711 2884

●

Chile: 800 HP INVENT, 123 800 360 999

●

China: 800 810 59 59, 10 6564 59 59

●

Colombia: 01 8000 51 HP INVENT, local 571 606 9191

●

Czech Republic: 420 261 307 310

●

Denmark: 70 11 77 00

●

Ecuador: 999 119, 1 800 225 528

●

Egypt: 202 532 5222

●

Finland: 0203 53232

●

France: 08 26 10 49 49

●

Germany: 0180 52 58 143

●

Greece: 210 6073603, 801 11 22 55 47

●

Guadaloupe: 0800 99 00 11, 877 219 8791

●

Guatemala: 1 800 999 5105, 1 800 711 2884

●

Hong Kong: 852 3002 8555

●

Hungary: 06 1 382 1111

●

India: 1 600 112 267

●

Indonesia: 350 3408

●

Ireland: 1 890 946500

●

Israel: 09 830 4848

●

Italy: 02 3859 1212

●

Jamaica: 0 800 711 2884

●

Japan: software 0120 014121, hardware 0120 742594

●

Korea: 82 1588 3003

●

Luxembourg: 27 303 303

●

Malaysia: 1 800 80 5405

●

Martinique: 0 800 99 00, 877 219 8671

●

Mexico: 01 800 472 6684, local 5258 9922

●

Middle East: 4 366 2020

●

Morocco: 2240 4747

●

Netherlands: 0900 1170 000

●

New Zealand: 09 365 9805

●

Norway: 800 62 800

●

Paraguay: 00 811 800, 800 711 2884
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●

Panama: 001 800 711 2884

●

Peru: 0 800 10111

●

Philippines: 632 888 6100

●

Poland: 22 566 6000

●

Portugal: 213 164 164

●

Puerto Rico: 1 800 652 6672

●

RSA: 27 11 258 9301, local 086 000 1030

●

Romania: 40 21 315 4442

●

Russia: 095 797 3520, 812 3467 997

●

Saudi Arabia: 6272 5300

●

Slovakia: 2 50222444

●

South Africa: 0800 001 030

●

Spain: 902 010 333

●

Sweden: 077 130 30 00

●

Switzerland: 0848 80 20 20

●

Taiwan: 886 2 872 28000

●

Thailand: 0 2353 9000

●

Tunisia: 71 89 12 22

●

Turkey: 216 444 71 71

●

UAE: 800 4520, 04 366 2020

●

Ukraine: 44 4903520

●

United Kingdom: 0870 842 2339

●

United States: 1 800 HP INVENT

●

Uruguay: 54 11 4708 1600

●

Venezuela: 0 800 HP INVENT, local 58 212 278 8000

●

Vietnam: 84 8 823 45 30

●

West Africa (French): 351 213 17 63 80
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Functional specifications
Table 17-1 HP 70 ink supplies
Printheads

Two inks in each printhead: gloss enhancer and gray, blue and
green, magenta and yellow, light magenta and light cyan,
photo black and light gray, and matte black and red

Ink cartridges

Cartridges containing 130 ml of ink: gloss enhancer, gray, blue,
green, magenta, yellow, light magenta, light cyan, photo black,
light gray, matte black, and red

Printer specifications

Table 17-2 Paper sizes

Roll Width

Minimum

Maximum

18 inches (460 mm)

24-inch printer: 24 inches (609 mm)
44-inch printer: 44 inches (1118 mm)

Roll Length

300 feet (91.4 m)

Sheet Width

8.3 inches (210 mm, A4 Portrait)

24-inch printer: 24 inches (609 mm)
44-inch printer: 44 inches (1118 mm)

Sheet Length

11 inches (279 mm, Letter Portrait)

24-inch printer: 36 inches (915 mm)
44-inch printer: 66 inches (1676 mm)

Table 17-3 Printing resolutions
Print
Quality

Maximum
detail

Extra
passes

Rendering Resolution
(dpi)

Printing Resolution (dpi)

Best

On

On

1200 × 1200

2400 × 1200 (glossy media only)*

On

Off

1200 × 1200

1200 × 1200

Off

On

600 × 600

600 × 600

Off

Off

600 × 600

600 × 600

On

600 × 600

600 × 600

Off

600 × 600

600 × 600

Off

300 × 300

300 × 300

On

600 × 600

600 × 600

Off

600 × 600

600 × 600

Off

300 × 300

300 × 300

Normal

Fast

* HP Premium ID Gloss, HP Premium ID Satin, HP Professional Satin Photo Paper, Photo Gloss, Photo
Semigloss/Satin, HP Contract Proofing Gloss, HP Contract Proofing Satin, Proofing Gloss, Proofing
Semigloss/Satin
Table 17-4 Margins
Top right and left margins

5 mm = 0.2 inches

Bottom margin (trailing edge)

5 mm = 0.2 inches (roll)
17 mm = 0.67 inches (sheet)
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Table 17-5 Mechanical accuracy
±0.2% of the specified vector length or ±0.1 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0
printing material in Best or Normal mode with HP Matte Film roll feed.

HP Designjet Z2100 Photo Printer Series standard

HP-PCL3 GUI

HP Designjet Z2100 Photo Printer Series with HP-GL/2
upgrade

HP-GL/2 RTL

Physical specifications
Table 17-7 Printer physical specifications
24 inch printer

24 inch printer (without stand)

44 inch printer

Weight

143 lb (65 kg)

103.6 lb (47 kg)

189 lb (86 kg)

Width

49.7 inches (1262 mm)

49.7 inches (1262 mm)

69.7 inches (1770 mm)

Depth

Minimum: 26 inches (661 mm)

Minimum: 26 inches (661 mm)

Minimum: 26 inches (661 mm)

Height

Maximum: 28.8 inches (732 mm) Maximum: 28.8 inches (732 mm)

Maximum: 28.8 inches (732 mm)

41.2 inches (1047 mm)

41.2 inches (1047 mm)

15.4 inches (391 mm)

Memory specifications
Table 17-8 Memory specifications
Memory (DRAM) supplied

128 MB

Hard disk

40 GB

Power specifications
Table 17-9 Printer power specifications
Source

100–240 V ac ±10%, auto-ranging

Frequency

50–60 Hz

Current

<2A

Consumption

< 200 W

Ecological specifications
For the up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search
for “ecological specifications”.
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Table 17-6 Graphic languages supported

Environmental specifications
Table 17-10 Printer environmental specifications

Printer specifications

Temperature range

Humidity range

Operating for optimal print quality

22°C to 26°C (72°F to 79°F)

30% to 60%

Operating for standard printing

15°C to 35°C (59°F to 95°F)

20% to 80%

Printer without consumables

5°C to 40°C (41°F to 104°F)

Non-operating packed consumables and
printer:

-40°C to 60°C (-40°F to 140°F)

Acoustic specifications
Printer acoustic specifications (declared according to ISO 9296).
Table 17-11 Printer acoustic specifications
Idle sound power level

4.4 B (A)

Operating sound power level

6.5 B (A)

Idle sound pressure at bystander

44 dB (A)

Operating sound pressure at bystander

29 dB (A)
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Glossary

AppleTalk A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now
recommends TCP/IP networking instead.
Bonjour Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a
computer network technology used in Apple's Mac OS X from version 10.2 onwards. It is used to discover services
available on a local area network. It was originally known as Rendezvous.
Color accuracy The ability to print colors that match the original image as closely as possible, bearing in mind
that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.
Color consistency The ability to print the same colors from a particular print job from print to print and from
printer to printer.
Color model

A system of representing colors by numbers, such as RGB or CMYK.

Color space A color model in which each color is represented by a specific set of numbers. Many different color
spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have
different color spaces, because a particular set of RGB numbers results in different colors on different monitors.
Cutter A printer component that slides back and forth across the platen to cut the paper.
ESD ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door,
or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic
discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some
precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may
reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type
of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD
sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic
charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when
handling ESD sensitive devices. Also, avoid working in low humidity environments.
Ethernet

A popular computer networking technology for local area networks.

Firmware Software that controls your printer's functionality and is stored semi-permanently in the printer (it can
be updated).
Gamut The range of colors and density values reproducible on an output device, such as a printer or monitor.
HP-GL/2 Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.
I/O

Input/Output: this term describes the passing of data between one device and another.

ICC The International Color Consortium, a group of companies that have agreed on a common standard for color
profiles.
Ink cartridge A removable printer component that stores ink of a particular color and provides it to the printhead.
IP address A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers
separated by dots.
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Jetdirect HP's brand name for its series of print servers that allow a printer to be connected directly to a local
area network.
LED Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.
MAC address Media Access Control address: a unique identifier used to identify a particular device on a network.
It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.
Nozzle

One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which
are pulped, dried, and pressed.
Platen The flat surface within the printer over which the paper passes while it is being printed on.
Printer driver Software that converts a print job in a generalized format into data suitable for a particular printer.
Printhead A removable printer component that takes ink of one or more colors from the corresponding ink
cartridge(s) and deposits it on the paper, through a cluster of nozzles. In the HP Designjet Z2100 Photo series,
each printhead prints two different colors.
Rendezvous
Spindle
TCP/IP
based.

Apple Computer's original name for its networking software later known as Bonjour.

A rod that supports a roll of paper while it is being used for printing.
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is

USB Universal Serial Bus: a standard serial bus designed to connect devices to computers.
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A
accessories
order 109
accounting 78
acoustic specifications 164
adding paper types 37
advance paper 39
alerts
errors 149
alerts, warnings 149
B
banding problems 119
basket
output problems 118
black and white 49
blurred lines 126
buzzer on/off 21
C
calibration
color 58
cannot load paper 114
clean the platen 129
clean the printer 94
clipped at bottom 132
clipped image 132
color 52
color calibration 58
color emulation modes 62
color management options 61
color management process 57
color management scenarios 64
color profiling 59
colors inaccurate 131
communication problems 146
components of printer 4
configure 21
connect the printer
choose a method 10
Mac OS direct 15
Mac OS network 12
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Windows direct 11
Windows network 10
contrast in front panel 21
core adaptors 26
Customer Care 156
cutter on/off 38
cutter, replace 94
D
draft printing 47
Driver features
QuarkXPress 149
drying time
change 38
E
ecological specifications 163
economize on ink 50
economize on paper 50
EFI Designer Edition RIP 110
Embedded Web Server
access 19
cannot access 147
ink and paper usage 78
language 20
printer usage statistics 78
environmental specifications 164
error messages, front panel 151
F
features of printer 4
file system check 148
firmware update 100
front panel
contrast 21
language 19
units 21
front panel option
adjust paper advance 120
align printheads 143
allow EWS 147
best 48
calibrate color 58

calibrate paper advance 120
clean printheads 139
emulate printer 62
enable buzzer 21
enable cutter 38
enable maximum detail 48
enable merge 45
enable more passes 48
fast 47
HP Designjet 500/800
series 62
ink cartridge information 82
internal prints 8
job queue 50, 110
load roll 29
load sheet 33
modify configuration 22
print diagnostic image 133
print quality 42
printer utility software 147
printhead information 85,
124, 127
purge ink 99
replace ink cartridges 83
replace printheads 86
reprint 50
reset cutter life counters 94
reset paper advance 120
scale 45
select display contrast 21
select drying time 38
select graphics language 22
select I/O timeout 132
select language 19
select paper size 42
select quality level 47, 48
select units 21
sleep mode wait time 20
unload paper 31, 35
view configuration 12
view connectivity
information 147, 148
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view loaded paper 36
view printer information 158
functional specifications 162
G
graininess 127
graphic languages 163
gray shades 49
H
hard disk specification 163
HP Advanced Profiling
Solution 110
HP Care Packs 156
HP Customer Care 156
HP Installation 157
HP Instant Support 157
HP Photosmart Pro 111
HP Proactive Support 157
HP Start-Up Kit 156
HP Start-Up Kit CD/DVD 2
HP Support 158
HP-GL/2 22
HP-GL/2 upgrade 109
I
image diagnostics print 133
image problems
clipped at bottom 132
clipped image 132
missing objects 133
PDF problems 133
Visio 2003 148
ink cartridge
about 82
cannot insert 138
insert 84
maintenance 99
order 104
remove 83
specification 162
status 82
ink usage, economize 50
Instant Support 157
internal prints 7
K
Knowledge Center 156
L
language 19
line thickness 124
load a sheet 31
load roll into printer 26
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load roll onto spindle 24, 25
loading paper problems 114
M
maintaining paper 38
maintenance kits 100
margins
none 49
specification 162
mechanical accuracy 163
media profiles 36
memory error (AutoCAD) 148
memory specifications 163
misaligned colors 125
move the printer 99
N
Network settings 21
O
order
accessories 109
ink cartridges 104
paper 104
printheads 104
overlapping lines 45
P
page size 42
paper
advance 119
cannot load 114
display information 36
paper advance calibration 119
paper jam 116
paper load advice 24
paper not flat 127
paper output problems in
basket 118
paper profiles
download 36
paper size 42
paper sizes (max and min) 162
paper types 37, 104
paper usage, economize 50
PDF clipped 133
PDF missing objects 133
physical specifications 163
platen cleaning 129
power specifications 163
preview a print 45
print job
ink usage 78
paper usage 78

print preview 45
print quality
select 42
print with shortcuts 43
print-quality problems
banding 123
black and white not
neutral 130
blurred lines 126
bottom of print 130
bronzing 130
discontinuous lines 126
edges darker than
expected 130
edges stepped or not
sharp 129
general 122
graininess 127
horizontal lines 123
ink marks 128
line thickness 124
misaligned colors 125
paper not flat 127
scratching 128
scuffing 128
stepped lines 124
vertical lines of different
colors 130
white spots 131
wizard 122
printer does not print 146
printer software
Mac OS uninstall 16
Windows uninstall 12
printer stand 109
printer status 94
Printer Utility
access 19
cannot access 147
language 20
printer's main components 4
printer's main features 4
printhead
about 85
align 142
cannot insert 138
clean; purge 139
insert 88
order 104
remove 86
replace, reseat 139
specification 162
status 85
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printhead cleaner
specification 162
printhead drop detector
clean 140
printing resolutions 162
Proactive Support 157
profiling, accessory 110
ProPrint 111
Q
quality, high 48
QuarkXPress, unavailable driver
features 149
R
reprint a job 49
rescale a print 44
RIP 110
roll paper
choose spindle 24
load into the printer 26
load onto the spindle 25
unload 30
S
safety precautions 2
satin photo paper 108
scale a print 44
scratched prints 128
scuffed prints 128
sheet paper
load 31
unload 35
shortcuts 43
sleep mode wait time 20
slow printing 146
software 7
software update 100
specifications
acoustic 164
ecological 163
environmental 164
functional 162
graphic languages 163
hard disk 163
ink supplies 162
margins 162
mechanical accuracy 163
memory 163
paper size 162
physical 163
power 163
printing resolutions 162
spectrophotometer 56
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stand 109
statistics
ink cartridge 82
printer usage 78
stepped lines 124
store the printer 99
support services
HP Care Packs 156
HP Customer Care 156
HP Instant Support 157
HP Proactive Support 157
HP Start-Up Kit 156
HP Support 158
Knowledge Center 156
printer installation 157
warranty extensions 156
switch the printer on/off 18
T
telephone numbers 158
U
unload a sheet 35
unload roll from printer 30
using this guide 2
V
Visio 2003, no output 148
W
warranty extensions 156
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